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Preface

This user guide:

Describes how to configure RAID mode on AMD platforms.
Provides information about arrays, disks, and RAID levels (RAID types).

Describes how to improve storage system performance or reliability by understanding
array and disk tasks and options.

Describes how to acquire and load RAIDXpert2 drivers for Windows®, Windows 7
32-bit, Windows 7 64-bit, Windows 10 64-bit and later operating systems and Linux®
operating systems.

Describes the features and procedures for using RAIDXpert2, which is the
RAIDXpert2 GUI.

Intended Audience

This user guide is intended for use by system administrators and technicians who are experienced
with the following:

Direct Attached Storage (DAS), Storage Area Network (SAN), or Network Attached
Storage (NAS) operators

Network administration
Network installation

Storage system installation and configuration

Prerequisites

Prerequisites for installing and configuring this product include familiarity with:

Servers and computer networks
RAID and input/output signal technology (such as SCSI, SATA, or NVMe)
Fibre Channel and Ethernet protocols

Preface 13
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Document Conventions and Symbols

Table 1. Document Convention

Convention

Element

Navy blue, underlined text
(http.//www.example.com)

Web site addresses

Bold font

Key names
Text typed into a GUI element, such as into a box

GUI elements that are clicked or selected, such as menu and list
items, buttons, and check boxes

Italics font

Text emphasis

Monospace font

File and directory names
System output

Code

Text typed at the command line

Monospace, Italic font

Code variables
Command line variables

Monospace, bold font

Emphasis of file and directory names, system output, code, and
text typed at the command line

Customer Support

For customer support, contact

Glossary

Table 2. Glossary of Terms

your system supplier or motherboard vendor.

Term

Definition

rcadm

A command line interface (CLI) tool for managing RAID controllers on
Linux®, on Windows®, and UEFI operating systems. It is used for
creating, transforming, and deleting arrays; and adding and removing
disks.

Legacy disk

Legacy disks include new or unrecognized disks which may contain data

or even an operating system. Legacy disks appear in the BIOS

Configuration Utility and in RAIDXpert2 as legacy arrays. When the

legacy disk is initialized, configuration data is written to the disk. The

legacy array then becomes an online disk usable in arrays.

CAUTION: 4 legacy disk can contain valid data. When a legacy disk is
initialized, all data on the disk is lost.

Linux®

Free, open-source UNIX-based operating system.

14
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Chapter 1 Safety Precautions

1.1 General

This section includes general safety precautions and specific RAIDXpert2 cautions. Read and
keep this user manual for future reference.

1.2 Safety Definitions

CAUTION: Indicates that failure to follow directions could result in damage to equipment or
data.

IMPORTANT: Provides clarifying information or specific instructions.
Note: Provides additional information.

TIP: Provides helpful hints and shortcuts.

1.3 Caution Messages
This section lists the Caution messages that appear in the book.

1.3.1 Caution Messages About Disks

CAUTION: 4ssigning a dedicated spare does not reserve space on the disk. Therefore, an
automatic restore is not guaranteed if a disk fails. If a disk fails, make space on the
disk for the fail-over to complete, or assign a different disk with enough space. If a
dedicated spare is assigned and a disk fails, the restore process starts automatically,
if there is enough space available on the dedicated spare.

CAUTION: If a disk is part of an AMD-RAID array, the disk cannot be selected for initialization.
To initialize the disk anyway, delete the AMD-RAID array. Data on the disk is deleted
during initialization so ensure the correct disks are chosen to initialize.

CAUTION: 4 legacy disk can contain valid data. When a legacy array is deleted, or when its
corresponding legacy disk is initialized, the data is lost.

CAUTION: When a disk is initialized, all data on the disk is lost.
1.3.2 Caution Messages about Arrays

CAUTION: Deleting an array permanently destroys all data that is on the array. This action
cannot be undone and it is very unlikely the data can be recovered.

Chapter 1 Safety Precautions 15
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CAUTION: Do not delete the first array listed in the Arrays section, if it is the AMD-RAID
bootable array. Doing this deletes the operating system and AMD-RAID files.

CAUTION: Do not initialize a disk that is part of an array. Initializing a disk in a non-redundant
array deletes the array and its data. The array no longer appears in Array View. This
is especially true for a non-redundant bootable array. Initializing a disk in a non-

redundant bootable array causes the array to Fail and deletes the operating system,
AMD-RAID files, and device drivers.

CAUTION: Leaving Write Back Cache enabled can increase the likelihood of data being
corrupted if the system experiences a power interruption or unexpected shutdown.

CAUTION: Prior to removing an array, remove its drive letter (Windows) or unmount the array
(Linux®).

CAUTION: A4ll data contained in a AMD-RAID array are lost if the RAIDXpert2 disks of the
array are migrated to a non-AMD-RAID system.

CAUTION: When an array is securely erased, the data on the array is lost. The array remains
hidden after the secure erase completes. User must Un-hide the array for data
operations.

CAUTION: In some circumstances, more than eight arrays are possible. They might appear to
function properly, but are not supported.

CAUTION: Ifthe user creates an Array with Skip Initialization, the array will not be redundant.

CAUTION: Controller support for Socket SP3 compatible processors are as follows:
8-NVMe + 2-SoC + I-PT when set to RAID in the BIOS
10-NVMe when SoC and PT are Disabled in the BIOS
10-NVMe + I-PT when SoC is Disabled in the BIOS
9-NVMe + 2-SoC when PT is Disabled in the BIOS

CAUTION: Hot-Swapping is not recommended for disks that are part of AMD-RAID array.

CAUTION: Socket SP3 compatible processors support a maximum of 14 SATA ports on the
system depending on customer platform design (8 from PT SATA controller, 6 from
AMD SATA controller including devices connected to M.2 port).

CAUTION: Maximum number of disks (both NVMe and SATA) that can be used for
Creating/Transforming a Volume, RAID-0 and RAID-10 arrays is eight. For RAID-1
only two disks are supported.

CAUTION: RAID on AMD SP3 compatible processor platform M.2 port supports both AMD
SATA controller and PCle M.2 NVMe. At any given time, each M.2 port can support
either M.2 SATA or M.2 NVMe, but not both.
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CAUTION: Individual disks which are not part of a RAID array will not be listed in Device
Manager under the Disk Drive section. Individual Disks can be managed through
RAIDXpert2 web utility, HII and the EFI shell.

Chapter 1 Safety Precautions 17
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Chapter 2 Getting Started

2.1 RAIDXpert2 Technology

RAIDXpert2 consists of (a) storage management and (b) a RAID controller and port virtualization.
RAIDXpert2 runs on existing systems by using a motherboard’s built-in SATA ports, PCle M.2
slots and PCle NVMe Addin cards.

2.2 Who Should Use This Manual

Only trained, experienced, and authorized personnel should install RAIDXpert2 and use its
features and capabilities.

All unit operators must be familiar with system hardware, data storage, RAID technology,
input/output signal technology (such as NVMe, SCSI, SAS, or SATA), and Direct Attached
Storage (DAS), Network Attached Storage (NAS), and/or Storage Area Network (SAN) concepts
and technology.

The intended user audience of this user manual is system administrators and experienced users.
2.3 System Requirements for Using RAIDXpert2

Make sure the systems that use RAIDXpert2 meet the requirements indicated in Table 3.

Table 3. System Requirements for RAIDXpert2

Component Requirements

Memory (RAM) Minimum: 4 GB, 8 GB for AMD Ryzen® processors and AMD Family 17h
Models 60h-6Fh processors

Recommended: 8 GB, 16 GB for AMD Ryzen processors

Storage Devices 1-14 SATA or SSD drives or M.2 SATA drives or NVMe M.2 HHHL. The
number of disks depends on the number, type, and capacity of the arrays to
be created.
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2.3.1 Supported Processors and Chipsets
The following processors are supported by the current release of RAIDXpert2:

Table 4. Supported Processors and Chipsets

Supported Processors & Description
Chipsets
Supported AMD Processors AMD Ryzen™ Desktop Processor
AMD Ryzen™ Threadripper™ Processor
AMD Ryzen™ Desktop Processor with Radeon™ Vega Graphics
AMD Family 17h Models 60h-6Fh processors
Supported AMD Chipsets AMD X370 Chipset
AMD B350 Chipset
AMD X399 Chipset

2.3.2 Supported Operating Systems
RAIDXpert2 supports the following operating systems:

RC-9.2 x release:
e Microsoft® Windows® 10—64 bit.

RC-8.1 x Release:
e Microsoft Windows 7: Professional Edition, Ultimate Edition—32 bit and 64 bit
e Microsoft Windows 10—32 bit and 64 bit
e Red Hat Enterprise Linux® (RHEL) 7.3—64 bit
e Ubuntu Desktop Linux 16.04—32 bit and 64 bit

Chapter 2 Getting Started 19
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2.4 Features of RAIDXpert2

The features of RAIDXpert2 described in this user manual apply to all license levels and
supported operating systems.

Table 5 describes these features. Also see Table 6, on page 22, for a summary of features that are
available with the RAIDXpert2 Basic license.

Table S. Features of RAIDXpert2

RAIDXpert2 Feature Description

Arrays (general information) | RAIDXpert2 allows:

e An array refers to data storage created by RAIDXpert2 from one or
more disks. Although an array can be created from several disks, it is
seen by the operating system as a single disk.

e Creating arrays of different RAID levels using the same disks.

e Creating different RAID level arrays on the same disk, to adapt each
array to the I/O that it processes.

e Creating an array from a mix of different type disks. For example, a
RAID10 array can be created from a group of disks that contain two
SATA Il HDDs and two SATA SSDs or only on NVMe or group of
SATA and NVMe disks.

e Migrating an existing array to another RAID level, if the type of array
being used is not the optimal type for the application. This function
depends on the array capacity, redundancy level, RAIDXpert2 license
level and capacity of the drive or free space available.

Array Hiding An array can be hidden from the operating system so that neither the
software nor users can see or access it.

Array Recovery If a redundant array is accidentally deleted, it might be recovered by
creating a new array with the same properties as the deleted array. (This can
occur only if disk Write Access operations are not in-progress.)

Background Array The background initialization of a redundant array creates the redundant
Initialization (BGI) data that allows the array to survive a disk failure.

Background initialization allows a redundant array to be used immediately.
Data is not lost if a disk goes offline prior to completion of the BGI
process.

Cache Support for Arrays Various array-caching options are supported: No Cache, Read Ahead
Cache, Write Back Cache, Read Ahead and Write Back Cache.
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Table 5. Features of RAIDXpert2 (Continued)

RAIDXpert2 Feature

Description

Cache Support for Disks

Various disk-caching options are supported: No Cache, Read Ahead

Cache, Write Back Cache, Read Ahead and Write Back Cache.

Note: By default, NVMe Physical disk Read Ahead and Write Back cache
are always disabled. User cannot enable the setting as it may
impact the operational performance of the NVMe disk

Secure Erase

All data on an array can be erased and ensured it is unrecoverable, even
with advanced data recovery techniques.

Consistency Check A Consistency Check is a background operation that verifies and corrects
the mirror or parity data for fault-tolerant disks. It is recommended that a
Consistency Check be run periodically on an array.

Disk Roaming With disk roaming, SATA cables can be disconnected from their disks

and shuffled without confusing RAIDXpert2.

Note: Disconnect the SATA cables from the disks only when the system is

shutdown.

Disk roaming also allows:

e Disks to be moved to different slots in the backplane. RAID Xpert2
detects which disks belong to which arrays, regardless of where the
disks are moved in the backplane.

e Disk(s) to be moved between systems.

Note: It might not be possible to move disks between systems if they

contain boot arrays.

Fault Tolerance

The following fault tolerance features are available with RAIDXpert2, in
order to prevent data loss in case of a failed disk.

e Disk failure detection (automatic).

e Array rebuild using hot spares (automatic, if the hot spare is
configured for this functionality).

e Hot-swap manual replacement of a disk without rebooting the system
(available only for systems with a backplane that supports hot-
swapping) is not recommend for disks that are part of the Boot
Virtual Disk or are connected to the AMD RAID supported chipsets.
This applies to all chipsets.

For example if a disk fails in a RAID1, the array remains functional and

data is read from the surviving mirrored disk.

Mirror Rebuilding A broken mirrored array can be rebuilt after a new disk is inserted and the

disk is designated as a spare. The system does not have to be rebooted.
Multiple RAID Levels per Support for multiple array levels per disk allows the administrator to
Disk create arrays of different RAID levels using the same disks.

Chapter 2
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Table 5. Features of RAIDXpert2 (Continued)

RAIDXpert2 Feature

Description

Native Command Queuing

(NCQ)

Native Command Queuing is a command protocol of disks that are
supported by RAIDXpert2. NCQ enables individual disks to internally
optimize the order in which Read and Write commands are executed.
RAIDXpert2 permits a queue depth of up to 32 read/write commands per
disk.

Online Capacity Expansion
(OCE)

OCE is a process that allows the user to add storage capacity to an
existing array, without taking the system offline. OCE enables the user to
increase the total storage capacity of an array by integrating unused
storage into the array.

Data can be accessed while the disks are added and while data on the
array is being redistributed.

Online RAID Level Migration
(ORLM)

With online RAID level migration, users can easily move an array from
one RAID level to another. While the migration is taking place, data is
accessible and protected to the lowest protection of either the source
RAID level or the destination RAID level.

RAID Level Support

RAIDXpert2 supports RAID levels 0, 1, 10, Volume, and RAIDABLE.

Self-Monitoring Analysis and
Reporting Technology
(SMART)

SMART is a hard-disk-drive (HDD) capability which allows reporting of
reliability information. If a drive anticipates there is a high likelihood of
future failure it triggers a SMART error condition. RAIDXpert2 presents
this error condition so the drive can be replaced before the predicted
failure occurs.

2.5

RAIDXpert2 Feature Set

Table 6. Feature Set for RAIDXpert2: Basic License Level

License Level

Features Sub-Features RAIDXpert2 Basic
Create array Yes
Option ROM (BIOS) Support! Delete array Yes
Boot/INT13 control Yes
Create array Yes
Delete array Yes
UEEI Driver (BIOS) Support Raidxpert2 Configuration Yes

utility (HIT)!

efi Shell utility Yes
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Table 6. Feature Set for RAIDXpert2: Basic License Level (Continued)

License Level
Features Sub-Features RAIDXpert2 Basic

0 Yes

1 Yes

5 No
RAID Levels Supported?

10 Yes

RAIDABLE Yes

Volume Yes

No initialization Yes
Array Creation Foreground initialization Yes

Background array scan Yes
Array Deletion Yes
Array Transformation Yes

Global Yes
Sparing

Dedicated Yes

Background redundancy check Yes
Consistency Check

Scheduled Yes
Online Capacity Expansion (OCE)? Yes
Online RAID Level Migration (ORLM) Yes

Same-system support Yes
Drive/Disk Roaming*

Between-systems support Yes
RAIDXpert2 Web GUI (Management GUI) Yes
rcadm (management CLI) Yes
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Table 6. Feature Set for RAIDXpert2: Basic License Level (Continued)

License Level
Features Sub-Features RAIDXpert2 Basic
SATA Yes
SSD Yes
ATAPI Yes
Drive Interfaces Supported®
M.2 SATA SSD Yes
M.2 NVMe SSD Yes
HHHL NVMe SSD Yes
Dissimilar Disk Support Within The Same Array Yes
No Cache Yes
Read Ahead Cache Yes
Cache Support Write Back Cache Yes
Read Ahead and Write Back
Cache Yes
Create Array and Delete Array Functions Without
Rebooting Yes
Restore (Rebuild) Priority Yes
Multiple RAID Levels per Disk® Yes
Touched Region Logging’ Yes
E-mail Event Notification Yes
System Event Log Integration Yes
Instant Create Support® Yes
Hot-Swap Support Yes
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Notes:
1. At the AMD BIOS Page, arrays can be created or deleted with AMD BIOS Configuration Utility (HII)

or Option ROM. Option ROM support is available only with the RC-8.1 release. Array or physical disk
information can be displayed, assign Global or Dedicated spares and Critical or Offline arrays are
indicated. INT13 support can be turned off completely at the BIOS Configuration Utility. NVMe is not
supported by the Option ROM.

See Chapter 3, Understanding Arrays, Disks and RAID Levels, on page 26, for detailed information
about understanding arrays, RAID levels, and performance and reliability considerations.

The unique ability of RAIDXpert2 to provide online expansion to RAID levels across multiple disks
becomes extremely valuable when expanded storage is a requirement.

Disk roaming allows arrays to be moved from port to port, either within the same system or between
systems.

See the system’s motherboard specifications for the supported device interface. RC-8.1 and RC-8.2
branches support only SATA. RC-9.1 and above release branches support SATA, M.2 NVMe SSD and
HHHL NVMe SSD

Multiple RAID levels (array types) per disk allows the administrator to create different RAID levels on
the same disks. For example: The administrator wants data redundancy for the user data, and creates a
RAIDI set using part of the disks’ data. At the same time the administrator wants performance for the
swap spaces, and creates a RAID0 array using the rest of the disks’ capacities (space). This feature is
useful in collecting unused capacity from disks with different capacities. This feature increases data
integrity for redundant array types, by logging areas of an array that have been written to. In the event
of a system crash, the logged area’s consistency is checked and/or corrected. Without this feature, data
corruption might occur.

Arrays can be instantly created and used by skipping the background consistency check. For certain
types of redundant arrays this is a viable option and has no data integrity drawbacks. A consistency
check can always be done at a later time. If an initialization is skipped when creating a RAID1, the
array is not redundant until a consistency check is performed.

1t is not recommended to add a Disk to the system and to the array while the system is operating.

Chapter 2
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Chapter 3 Understanding Arrays, Disks and

RAID Levels

3.1 Understanding Arrays

Arrays are several disks that are grouped together to improve either the performance or reliability

of a storage system. Because some RAID levels enhance performance while others improve
reliability, it is important to consider the user’s needs when planning an array configuration.

Note: It is highly recommended that this user manual be reviewed in its entirety before

configuring arrays. Some of the advanced features of RAIDXpert2 (such as sparing options)

must be understood by the user before creating arrays.

3.2 RAID Levels

RAIDXpert2 supports the RAID levels indicated in Table 7.

Table 7. RAID Levels — General Characteristics

RAID Level Main Characteristic Use/Usefulness

RAIDO (Striping) Provides the highest performance | RAIDO arrays are useful for holding
but no data redundancy. Data in information, such as the operating
the array is striped (distributed) system paging file, where performance
across several disks. is extremely important but redundancy
Supports 2-8 disks. 1s not.

RAIDI Mirrors data on a partition of one | Useful when there are only two disks

(Mirroring) disk to another. available and data integrity is more
Supports 2 disks. important than storage capacity.

RAID10 (Striped Combines mirrors and stripe sets. | Offers better performance than a

RAID1 Sets) RAID10 allows multiple disk simple mirror because of the extra
failures, up to 1 failure in each disks.
mirror that has been striped. Requires twice the disk space of
Supports 4, 6, or 8 disks. RAIDI1 to offer redundancy.

26
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Table 7. RAID Levels — General Characteristics (Continued)

RAID Level Main Characteristic Use/Usefulness
Volume (JBOD) RAIDXpert2 treats one or more Provides the ability to link-together
disks or the unused space on a storage from one or several disks,
disk as a single array. regardless of the size of the space on
Supports 1 to 8 disks those disks.
Useful in scavenging space on disks
unused by other disks in the array.
Does not provide performance benefits
or data redundancy. Disk failure will
result in data loss.
RAIDABLE (also Allows a RAIDABLE disk to be | See RAIDO (Striping), on page 26 or
known as RAID transformed later to RAIDO or RAIDI (Mirroring) on page 26 for
Ready) RAIDI. post-transformation usefulness.

Supports one disk.

3.3 Array States

Within the management applications, an array is a logical device that can exist in one of four
states: Normal, Ready, Critical, or Offline.

e In RAIDXpert2, these states display in the Array List section in a column named

State.

e Within the rcadm Command Line interface, these states also display in a column
named State.

The array states are defined in Table 8, on page 28.

Chapter 3
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Table 8. Array States

State Description

Normal The Normal state is displayed when everything is functioning correctly.

Ready The Ready state is displayed while an array is being created.

Critical The Ceritical state is displayed when the array is no longer redundant (fault
tolerant) because of one or more disk failures. Arrays can still be read and written
to, but the data is no longer protected should another disk fail.

Offline The Offline state is displayed when arrays cannot be read or written to because of
one or more disk failures.

Whether an array is marked as Critical or Offline depends upon what RAID level it is and how
many disks within the array have failed. Note the changes in state in Table 9.

Table 9. Failure States by RAID Level

RAID Level This Failure State Is Displayed Whenever
RAID1 Critical A single disk fails.
(Redundant Arrays)
Offline Two disks fail.
RAIDI10 Critical A single disk fails in any one of the
(RAID Levels with Multiple sets.
Redundancies)
Offline All the disks in a set fail.
Volume and RAIDO Offline A single disk fails.

More than one array can be created using the same set of disks. If a disk is disconnected that
belongs to more than one array, only the arrays that try to access the disk and receive 1/O errors
report the failure. For example: there are two arrays, both of which are RAIDI1 sets, and both use
disk 4. If a system that is being used by array 1 receives an I/O error when trying to communicate
with disk 4, the state of array 1 changes to Critical. However, the state of array 2 using disk 4 does
not change to Critical until an I/O error is reported. If systems using array 1 are not
communicating with failed disk 4, the state of array 1 still displays as Normal.

If a rescan of all channels is performed after disconnecting a disk, the state of every array using
the missing disk changes from Normal to either the Critical or Offline, depending on the RAID
level.
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See Section 3.9, Rescanning Disks for Changes in State, on page 32 for a discussion of when to
rescan disks and the outcomes when doing so.

3.4 Creating Arrays: Future Expansion

When creating arrays, consider whether disk capacity needs to expand in the future. If the file
system must be expanded, perform the tasks indicated in Table 8.

Table 10. Array Expansion Considerations

Operating System Do This... And Consider This...
Microsoft® Windows® Format the arrays with 1. The Diskpart.exe utility version
NTEFS. Microsoft depends on which version of the
Corporation provides a Windows operating system is

utility (Diskpart.exe) that can | running.

dynamically extend an NTFS | 2. The Diskpart.exe utility can be
file system onto any unused | found on the CD for some versions

adjacent space. of Windows operating systems, or on
Note also that using a single | the Microsoft Corporation website
partition per array makes (http://www.microsoft.com)
expansion much easier. for other versions. Use the correct

version for the operating system.

Linux Use an expandable file Because RAIDXpert2 software is
system. limited to eight arrays, if a large
number of logical volumes are
needed, use a logical volume

manager (LVM).

3.5 Expanding Disk Capacity Online: Using OCE
Online Capacity Expansion (OCE) allows:

e Adding disks to an array at any time to increase an array’s capacity.
e Accessing the array data while it is being redistributed.

To increase the size and organization of an array, transform the array. For more information about
transforming arrays, see Section 9.6.3, Transform Arrays on page 100.

3.6 Migrating RAID Levels Online: Using ORLM

Online RAID Level Migration (ORLM) allows an array to move from one RAID level to almost
any other RAID level. This task includes migrating the array from a non-redundant RAID level to
a redundant RAID level.
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Prior to starting a RAID level migration/transformation, make sure that the disks selected for the
destination array have sufficient capacity. RAID level migration/transformation can occur only
when the destination array has the same or larger capacity as the source array.

While the migration/transformation is taking place, data is accessible and protected to the lowest
protection of either the source RAID level or the destination RAID level.

The Transform task can also be used to expand the capacity of an array, by using OCE. It can also
be used as part of the system backup and recovery strategy through the use of the RAID1 and
RAID10 levels.

To perform this process, see Section 9.6.3, Transform Arrays on page 100.

3.7 Array Tasks: Starting and Stopping Tasks
Tasks are started when one of the following actions are performed:

e C(reate a redundant array.

e Transform an array.

e Restore an array.

e Securely erase an array.

e Check for consistency on redundant arrays.

e Verify that data was not corrupted after a system crash (Check Bitmap performed
automatically).

Full task control can be used on Create, Consistency Check and Bitmap Check tasks. On a
Transform or Restore task for dedicated and global spares, task control can only pause/resume, but
it cannot remove the task. To remove these types of tasks, pause and then remove them.

The tasks indicated in Table 11 on page 31, can be displayed for each array.
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Table 11. Types of Tasks per Array

Task

When Displayed

Transform

While an array is being transformed.

Create

While an array is being created.

Consistency Check

While verifying the mirror disk (RAID1 or RAID10) consistency is correct.

(For redundant type arrays only.)

Restore

While an array is being restored.

Secure Erase

While an array secure erase is being performed.

Check Bitmap

While verifying that the mirror halves on a RAID1 or RAIDI1O0 set, are
consistent. This action is performed automatically to ensure that data is not
corrupted whenever a system crashes.

Not_Active

When no other tasks are being performed.

3.8 Understanding Disks

3.8.1 Disks States

AMD-RAIDXpert2 User Guide

Within the management applications, a disk can be part of one or more arrays and can exist in one
of five states: Online, Offline, New, Legacy, or SMART Error.

e In RAIDXpert2, these states are displayed in the Disk List section in a column named
State. See Table 20, on page 90, for additional information.

e Within the rcadm command line interface, these states are also displayed in a column

named State. See Table 33, on page 116, and Table 34, on page 117, for additional

information.
The disk states are defined in Table 12.
Table 12. Disk States
Disk State When Displayed
Online Whenever the disk is connected, functioning correctly, and RAIDXpert2 can
communicate with it.
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Table 12. Disk States (Continued)

Disk State When Displayed
New Whenever an uninitialized, new disk is connected.
Legacy Whenever a disk containing non-RAIDXpert2 configuration data is connected.
Offline Whenever the disk fails and RAIDXpert2 detects an error condition on the disk.
SMART Error | Whenever the disk reports a SMART error(s) to RAID Xpert2.

A disk can be a member of multiple arrays. A disk failure in one array doesn't necessarily mean it
has failed in other arrays.

After a rescan is performed the following can occur:

e A disconnected disk no longer appears in the Disk List (although the disk appears as
Missing in the Array View for the arrays to which it belonged).

e A disk that experiences a catastrophic failure appears in the Disk List as Offline and is
highlighted in red. The disk appears as Failed for the arrays to which it belonged.

e A disk that has a SMART error appears in the Disk List as SMART Error. (A disk
with a SMART error can’t be used to create an array)

e A disk that experiences a software-related failure appears in the Disk List as Online
and 1s highlighted in red. New arrays can be created with the disk.

Arrays that exist on a failed or disconnected disk might not be designated as Failed or Missing
until the system attempts to communicate with the failed or disconnected disk.

3.9 Rescanning Disks for Changes in State

The information displayed in the Disk List section is the state of the disks when they were last
scanned. If a rescan has not been performed, the information being displayed is the state of the
disks at boot time.

Every time a disk is connected or disconnected while online, a message asks if the user wants to
perform a rescan (of all SATA channels). If Rescan is selected, the information in both the Array
List and the Disk List is updated. This view might show arrays as being in a Critical or Offline
state, if all disks have not been installed or removed.

Although it is highly recommended that the system be shut down before adding or removing disks,
disks can be added or removed while the system is online (“hot-swapping”), if the system supports
the hot-swapping function. This is not recommended for disks that are part of the Boot Virtual
Disk or those that are connected to the AMD RAID supported chipsets.
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Because of this function, RAIDXpert2 does not automatically perform a rescan when it detects
that a disk has been added or removed. For example, to hot-swap a RAID1 set with two disks into
a new system, do not perform a rescan until both disks have been connected.

Arrays associated with the disks that are not yet connected change state to either Critical or
Offline. In the example above, if the state of the RAID1 set changes to Offline, data is unavailable.

Rescanning can also result in the state of a disk being reported differently in the Array View and

the Disk List. A disk within an array can have a state of Failed in the Array View field, while at
the same time it can show a state of Online in the Disk List.

3.10 Sparing Options: Disks and Arrays

RAIDXpert2 supports multiple sparing options. Spares are restored in the order indicated in Table
13.

Table 13. Sparing Options

Option Description
Dedicated A spare disk assigned to a specific redundant array.
Global A spare disk that is shared by multiple arrays.

Note: An array is marked Critical or Offline if a disk reports a Failed state to an I/O, or if the
Disk, SATA cable, or power cable is disconnected.

Note: One or more spares can be assigned to a redundant RAID level.

Note: Spare assignments do not apply to non-redundant RAID levels. To protect data, transform
the array to a redundant RAID level. Spares can then be assigned.

3.11 Dedicated Sparing

A dedicated spare is a disk that is assigned as an alternate disk for a specific array. Should a disk
fail in that array, the alternate disk is used to replace the failed disk and the array is rebuilt.

A dedicated spare can be assigned to any redundant array type, and up to four spares can be
assigned to an array.

Note: Disk capacity of the Dedicated Spare must be greater or equal to the capacity of the
smallest disk in the array.

CAUTION: 4ssigning a dedicated spare does not reserve space on the disk. Therefore, an
automatic restore is not guaranteed if a disk fails. If a disk fails, make space on the
disk for the fail-over to complete, or assign a different disk with enough space. If a
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dedicated spare is assigned and a disk fails, the restore process starts automatically,
if there is enough space available on the dedicated spare.

For additional information, see Section 9.6.13, Add or Remove Dedicated Spares, on page 108.

3.12 Global Sparing

A global spare is a disk that is assigned as an alternate disk for multiple arrays, instead of
associating it with only one array.

Many arrays can be restored using the global spare disk, as long as it is not already part of the
array and it has enough space available. Unlike a dedicated spare, this type of spare can be
assigned at any time, even while tasks are running on arrays.

Assigning a disk for use as a global spare does not reserve space on that disk. An automatic restore
is not guaranteed if a disk fails.

If there is not enough disk space on the global spare, make room for the fail-over to complete, or
assign a different disk with enough capacity as the spare. If there is enough space available on the
global spare and a disk failure occurs, the restore process starts automatically.

For additional information, see Section 9.6.14, Add or Remove Global Spares, on page 109.

3.13 RAID Performance Considerations

With RAID technology, performance is based on the following considerations:

e The number and organization of disks in an array.
e Caching attributes used for the array.
e Application workload.

3.13.1 Number and Organization of Disks

RAID functions increase performance by putting more disks to work and by buffering data for the
host.

Many disks can transfer data at greater than 100 MB per second. RAIDXpert2 can aggregate this
bandwidth in an almost linear fashion, as more of the same disks are included in an array.

3.13.2  Caching Attributes

Arrays can also be configured to provide Read and Write Back cache, Write Back cache, Read
Ahead cache and No cache option with RAIDXpert2 configuration utility and WebGUI utility, if
desired. Write Back caching has a large effect on most workloads, but should be used with
caution.
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3.13.3  Application Workload

When configuring an array, workload is probably the most important performance variable. Most
applications do many more reads than writes. The best performance is obtained with array types
like RAIDO or RAID10.

3.14 RAID Reliability Considerations

RAID reliability is enhanced through data redundancy and backup.

3.14.1 Data Redundancy

RAIDI1 or RAIDI10 are necessary for redundancy. With redundancy, both capacity and
performance are sacrificed for reliability. With RAIDXpert2, extremely high performance is
obtained even with redundant-type arrays.

3.14.2  Backup

It is good practice to back up your data periodically in case of a catastrophic failure. Tape backup
or other media can be used to secure your data.

3.15 Flexibility and Expansion Considerations

Before configuring an array, consider the following points to enhance the flexibility of the RAID
system.

3.16 Multiple RAID Levels

With RAIDXpert2, different RAID levels can be created on the same disk, to adapt each array to
the I/O that it processes. Also, more than one array can be created per disk.

Depending on the array capacity and redundancy level, an existing array can be transformed to
another RAID level, if the level of the array being used is not the optimal RAID level for the
application. Also, different arrays with different characteristics can be built for different
applications.
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Chapter 4 Platform RAID Enablement
Prerequisites

This chapter assists to configure and enable RAID mode in Platform BIOS for the listed AMD
products in Table 4 on page 19.

Note: Prior to starting the below procedure, Platform should be programmed with RAID
Supported BIOS. Obtain the BIOS from your system supplier or motherboard vendor.

4.1 Platform BIOS Settings - Enable RAID for the
AMD SP3-Series Chipsets

Note: The steps to configure a system to RAID mentioned here are specific to AMD NDA BIOS
based off the AMI BIOS.

1. Power-on the system.
2. Press Delete or ESC to enter the System BIOS setup page
3. In the BIOS setup:
a. Select the Advanced tab, then press Enter
b. Select the AMD PBS tab, then press Enter
c. Set NVMe RAID Mode to Enabled
4. In the BIOS setup:
a. Select the Advanced tab, then press Enter
b. Select the AMD CBS tab, then press Enter
c. Select FCH Common Options, then press Enter
d. Select SATA Configuration Options, then press Enter
e. Set SATA Controller to Enabled.
5. In the BIOS setup:
a. Select the Advanced tab, then press Enter
b. Select the AMD CBS tab, then press Enter
c. Select FCH Common Options, then press Enter
d. Select SATA Configuration Options, then press Enter
e. Set SATA Mode to RAID.
6. In the BIOS setup:
a. Select the Advanced tab, then press Enter
b. Select Promontory Common Options, then press Enter
c. Select PT SATA Configuration Options, then press Enter
d. Set PT SATA Port Enable to Enabled.
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7. In the BIOS setup:
a. Select the Advanced tab, then press Enter
b. Select Promontory Common Options, then press Enter
c. Select PT SATA Configuration Options, then press Enter
d. Set PT SATA Mode to RAID.
8. In the BIOS setup:
a. Select the Advanced tab, then press Enter
b. Select CSM Configuration, then press Enter
c. Set CSM Support to Enabled
9. In the BIOS setup:
a. Select the Advanced tab, then press Enter
b. Select CSM Configuration, then press Enter
c. Set Boot Option Filter to UEFI Only
10. In the BIOS setup:
a. Select the Advanced tab, then press Enter
b. Select CSM Configuration, then press Enter
c. Set Storage -> UEFI
11. Save (F4) the setting and restart the system.
12. To proceed with RAID array creation, Refer to Section 5.5.2, Create an Array, on page 41.

4.2 Platform BIOS Settings — Enable RAID for the
AMD Socket AM4- Compatible Processors

Note: The steps to configure a system to RAID mentioned here are specific to AMD NDA BIOS
based off the Insyde BIOS.

Power-on the system
Press ESC to enter the System BIOS setup page
Select Setup Utility, then press Enter
In the BIOS setup:
a. Select the Advanced tab
b. Select IDE Configuration, then press Enter
c. Set SATA Configure as to RAID, then press Enter
d. Set Force RAID Mode to Enabled, then press Enter
5. In the BIOS setup:
a. Select the Boot tab
b. Set Boot Type to UEFI Boot Type or Dual Boot Type, then press Enter
c. Set EFI Device First to Enable, then press Enter
6. In the BIOS setup:

b=
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a. Select the AMD-PBS tab
b. Set NVME RAID Mode to Enabled, then press Enter
7. In the BIOS setup:
a. Select the AMD-CBS tab
b. Select FCH Common Options, then press Enter
c. Select SATA Configuration Options, then press Enter
d. Set SATA Controller to Enabled, then press Enter
e. Set SATA Mode to RAID, then press Enter
8. In the BIOS setup:
Select the AMD-CBS tab
Select Promontory Common Options, then press Enter
Select PT SATA Configuration Options, then press Enter
Set PT SATA Port Enable to Enabled, then press Enter
e. Set PT SATA Mode to RAID, then press Enter
9. Save and restart.

a o op

10. To proceed with RAID array creation, Refer to Section 5.5.2, Create an Array, on page 41.
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Chapter 5 BIOS Configuration Utility
(Option ROM)

Before you begin, enable platform RAID mode by referring to Chapter 4, Platform RAID
Configuration Prerequisites.

5.1 When to Use the AMD-RAID Controller BIOS
Configuration Utility

Note: For OPROM to get listed, set both AMD and PT SATA Controller to RAID.

Note: OPROM will not be visible when Boot mode is set to UEFI only.

Note: OPROM supports only SATA devices with RC-8.1 release

Note: OPROM is applicable only to AMD Ryzen™ Desktop Processor Products

The AMD-RAID Controller BIOS Configuration Utility is also known as the Option ROM.
OPROM can be used to accomplish the below RAID functional procedures indicated in Table 14.

Table 14. When to use the AMD-RAID Controller BIOS Configuration Utility (Option

ROM)

Procedure Description Find Information At

Initialize a new disk To initialize a new disk drive for data Section 5.4, Initialize Disks, on page 40
storage.

Create or delete arrays | Create arrays at different RAID levels Section 5.5, Create Arrays, on page 41.
(depending on the license level for the
system), or delete an array.

Swap arrays Change the array order, especially for Section 5.5.5, Swap Arrays, on page 45
the AMD-RAID bootable array.

Manage hot spares Allows selection of global and dedicated | Section 5.5.6, Manage Spares, on page 45
hot spares.

View disk and array View information about each disk or Section 5.5.7, View Disk Details, on page 46

details array. Section 5.5.8, View Array Details, on page

47

Rescan all channels Rescan all channels to detect new or Section 5.5.9, Rescan All Channels, on
removed disks and arrays. page 47.

Change controller Change INT13 boot support, turn off Section 5.5.10, Change the Controller

options Critical arrays or warning for Offline Options, on page 47
arrays while booting, or change the
number of disks that can be spun-up
when the system is powered-on.

Continue to boot Exit the BIOS Configuration Utility and | Section 5.5.11, Continue Booting from the
continue booting the system. BIOS Configuration Utility, on page 48
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5.2 Access the AMD-RAID Controller BIOS
Configuration Utility (OPROM)

Note: OPROM can be accessed only when Boot mode is set to Dual boot type or Legacy boot type.

When booting the system, press Ctrl + R when the BIOS banner displays. There is a maximum of
three seconds to use this key combination to enter the BIOS Configuration Utility.

Note: If'the BIOS Configuration Utility does not display, contact your system or motherboard
supplier.

5.3 Understanding the Color Code in the BIOS
Configuration Utility

Color codes indicate the type or status of information at the BIOS Configuration Utility. See Table
15.

Table 15. BIOS Configuration Utility Color Codes

Color Description

White text Indicates an available option or informational text.

Black text, yellow highlighting | Indicates an option or device for which action might be taken.

Yellow text Indicates information about the yellow-highlighted option.

Green text Indicates an item that has been selected.

Light blue text Indicates that the item cannot be selected.

Magenta text Indicates items that are related to spares.

Red text Indicates a failed virtual or physical disk or a warning. For example,

informational text might be red if an option is not available.

5.4 Initialize Disks

New disks and legacy disks must be initialized before they can be used to create an AMD-RAID
array.

Initialization writes AMD-RAID configuration information (metadata) to a disk.
5.4.1 Initialize Disks
CAUTION: If a disk is part of an AMD-RAID array, the disk cannot be selected for initialization. To

initialize the disk anyway, delete the AMD-RAID array. Data on the disk is deleted during
initialization so ensure the correct disks are chosen to initialize.
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CAUTION: 4 legacy disk can contain valid data. When a legacy array is deleted, all data on the
disk is lost.

1. At the Main Menu, use the arrow keys to highlight Initialize Disk(s).
2. Press Enter to select Initialize Disk(s).
3. Select the disks to initialize:

e To select all disks, press the A key

e To select individual disks, highlight a disk with the arrow keys and press Insert. Any
number of disks may be selected using this method

4. Press Enter to initialize the selected disks or press ESC to cancel the initialization.

Initialization takes 10 to 15 seconds per disk. During initialization, a status indicator shows which
disk is being initialized. When the initialization is complete, the status indicator turns off. A
complete rescan of all channels is done automatically during initialization.

5.5 Create Arrays

Arrays can be created after the disks are initialized. See Section 3.2, RAID Levels, on page 26, for
deciding what type of RAID levels to use for the array.

TIP: See also Section 9.6.1, Create and Format Arrays, on page 97, and Section 10.4, Create New
Arrays: rcadm --create, on page 118.

5.5.1 Before You Begin

¢ In some circumstances, more than eight arrays are possible. They might appear to function
properly, but are not supported by AMD-RAID.

e For redundant arrays, the Create process starts after the operating system and AMD-RAID OS
drivers have been installed and the system has booted to the operating system. However, the
arrays are immediately available to use for either a bootable array or a data array.

e Array numbers are valid only for a given boot, and might be different in the BIOS
Configuration Utility and RAIDXpert2. If a permanent label is required, use the Array Naming
feature.

e At any point in the procedure, return to a prior window by pressing ESC.

e If'the system is booted from an AMD-RAID bootable array, the first array in the Arrays
section must be the bootable array. The system boots only from the first array in the Arrays
section. As necessary, use the Swap Two Arrays feature to swap arrays and place the
RAIDXpert2 bootable array in the first position.

5.5.2 Create an Array

1. At the Main Menu, use the arrow keys to highlight Create Array.
2. Press Enter.
3. Select the disks with which to create the array:
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e To select all disks, press the A key

e To select individual disks, highlight a disk with the arrow keys and press Insert. Any
number of disks may be selected using this method

4. Press Enter to include the selected disks in the array.

5. In the User Input section, use the arrow keys to select an array type. Only array types that can
be created with the selected disks are available.

6. Press Enter.
7. Select an array size by doing the following:
a. To create an array whose size is less than or equal to 2.199 TB:

e Press the Page Up or the up arrow key to increase the array size and the Page Down
or down arrow key to decrease the size.

e Press Enter when the desired size is reached.

b. To create an array whose size is greater than 2.199 TB:
e Press the Page Up or the up arrow key to increase the array size.
e Press Enter when the desired size of 2.199 TB is reached.

Note: 4 message displays stating that a size greater than the maximum is being
attempted, and whether the size of the array should be limited.

e Press ESC to bypass the Page Up or the up arrow key to continue modifying the size.
e Press Enter when either the desired size or the maximum available size is reached.

8. Select a caching level using the arrow keys then press Enter.

9. Press the C key to confirm the array settings or press ESC to go back to a previous page.

10. Repeat step 8 through step 11 to create additional arrays.

Note: When installing the operating system to an AMD-RAID bootable array, modify the boot
priority list in the motherboard BIOS. See the motherboard’s user documentation for
more information. Ensure that the AMD-RAID bootable array is included in the boot
priority list.

11. Ensure that INT13 support is enabled on the RAID controller, as described in Section 5.5.10,
Change the Controller Options, on page 47.

5.5.3 Create an AMD-RAID Bootable Array
CAUTION: Do not use eSATA drives for bootable arrays as they are removable.

The operating system and RAIDXpert2 files can be installed to a RAIDXpert2 bootable array. Use
the procedure in Section 5.5.2, Create an Array, on page 41, to create the bootable array. Ensure it
is the first array listed in the Arrays section of the BIOS Configuration Utility.

To install the operating system and RAIDXpert2 files see Chapter 7, Software Installation, 59.
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5.5.3.1 Create RAIDABLE Array
Note: Refer to Table 7 for RAIDABLE array characteristics.

At the Main Menu, use the arrow keys to highlight Create Array, then press Enter.
Select the appropriate disk using Insert to create the RAIDABLE array level, then press Enter
In the User Input section, use the arrow keys to select RAIDABLE, then press Enter.

b=

In the Caching mode section, use the arrow keys to select the Cache setting for the array, then
press Enter

5. Press the C key to confirm creation of array or press the ESC key to go back to a previous
page.
6. RAIDABLE array listed in the Arrays section

5.5.3.2 Create Volume Array
Note: Refer to Table 7 for Volume array characteristics.

1. At the Main Menu, use the arrow keys to highlight Create Array, then press Enter.

2. Select the appropriate number of disks using Insert to create the Volume array level, then
press Enter

3. In the User Input section, use the arrow keys to select Volume, then press Enter.
To set the Desired Array capacity, Use Page-UP or Page-Down key, then press Enter

5. In the Caching mode section, use the arrow keys to select the Cache setting for the array, then
press Enter

6. Press the C key to confirm creation of array or press the ESC key to go back to a previous page.
7. Volume array listed in the Arrays section

5.5.3.3 Create RAIDO Array
Note: Refer to Table 7 for RAIDO array characteristics.

1. At the Main Menu, use the arrow keys to highlight Create Array, then press Enter.

2. Select the appropriate number of disks using Insert to create the RAIDO array level, then press
Enter

3. In the User Input section, use the arrow keys to select Volume, then press Enter.
To set the Desired Array capacity, Use Page-UP or Page-Down key, then press Enter

5. In the Caching mode section, use the arrow keys to select the Cache setting for the array, then
press Enter

6. Press the C key to confirm creation of array or press the ESC key to go back to a previous page.
7. RAIDO array listed in the Arrays section

55.34 Create RAID1 Array

Note: Refer to Table 7 for RAIDI array characteristics.
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At the Main Menu, use the arrow keys to highlight Create Array, then press Enter.

Select the appropriate number of disks using Insert to create the RAID1 array level, then press
Enter

In the User Input section, use the arrow keys to select Volume, then press Enter.
. To set the Desired Array capacity, Use Page-UP or Page-Down key, then press Enter

In the Caching mode section, use the arrow keys to select the Cache setting for the array, then
press Enter

Press the C key to confirm creation of array or press the ESC key to go back to a previous page.
RAIDI1 array listed in the Arrays section

S5.3.5 Create RAID10 Array

Note: Refer to Table 7 for RAID10 array characteristics.

1.
2.

6.
7.

At the Main Menu, use the arrow keys to highlight Create Array, then press Enter.

Select the appropriate number of disks using Insert to create the RAID10 array level, then
press Enter

In the User Input section, use the arrow keys to select Volume, then press Enter.
. To set the Desired Array capacity, Use Page-UP or Page-Down key, then press Enter

In the Caching mode section, use the arrow keys to select the Cache setting for the array, then
press Enter

Press the C key to confirm creation of array or press the ESC key to go back to a previous page.
RAID10 array listed in the Arrays section

554 Delete Arrays

CAUTION: Deleting an array permanently destroys all data that is on the array. This action

cannot be undone and it is very unlikely the data can be recovered.

CAUTION: Do not delete the first array listed in the Arrays section, if it is the AMD-RAID

bootable array. Doing this deletes the operating system and AMD-RAID files.

5.5.4.1 Delete an Array
1. At the Main Menu, use the arrow keys to highlight Delete Arrays then press Enter.
2. Select the arrays to delete:
e To select all arrays, press the A key.
e To select individual arrays, highlight an array with the arrow keys and press Insert.
Any number of arrays may be selected using this method.
3. Press Enter to delete the selected arrays. A warning message displays.
4. Press the C key to confirm the deletion, or press the ESC key to exit to the Main Menu.
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5.5.5 Swap Arrays
Use the Swap Two Arrays option to arrange arrays in a different order.
5.5.5.1 Before You Begin

e [fmore than one array is created, install the operating system to any of them. However, a small
amount of boot information is always written to a disk(s) in the first array (Array 1) of the
Array section, regardless on which array the operating system is installed.

e It is recommended that the user install the operating system on an AMD-RAID bootable array
at a redundant RAID level, such as RAID1 or RAID 10 and swap the array into the first
position, if it is not already Array 1.

e Swapping arrays can be performed only at the BIOS Configuration Utility.

5.5.5.2 Swap Arrays

1. Atthe Main Menu, use the arrow keys to highlight Swap Two Arrays, then press Enter..
2. Select the arrays to swap:

a. Highlight an array using the arrow Kkeys.

b. Press Insert to select it.

c. Highlight a different array using the arrow keys.

d. Press Insert to select it.
3. Press Enter to swap the arrays.

5.5.6 Manage Spares
This option allows the user to assign or unassign global or dedicated spares.
5.5.6.1 Assign Global Spares

1. At the Main Menu, use the arrow keys to highlight Manage Host Spare(s), then press
Enter.

2. Use the arrow keys to highlight Assign Global Hot Spare(s), then press Enter.
3. Select the disks to assign as global spares:
e To select all disks, press the A key

e To select individual disks, highlight a disk with the arrow keys and press Insert. Any
number of disks may be selected using this method

4. Press Enter to assign the selected disks as global spares.

5.5.6.2 Assign Dedicated Spares

1. At the Main Menu, use the arrow keys to highlight Manage Host Spare(s), then press
Enter.

2. Use the arrow keys to highlight Assign Dedicated Hot Spare(s), then press Enter.
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3. Use the arrow keys to highlight the array. (must be a redundant array)
4. Press Insert to select the array, then press Enter.
5. Select the disks to assign as dedicated spares.

e To select all disks, press the A key.

e To select individual disks, use the arrow keys to highlight the disk and press Insert to
select it. Any number of disks may be selected using this method.

e Press Enter.
6. Press the C key to continue, or press the ESC key to return to the Main Menu.

5.5.6.3 Un-Assign Spares

1. At the Main Menu, use the arrow keys to highlight Manage Host Spare(s), then press
Enter.

2. Use the arrow keys to highlight Unassign Hot Spare(s), then press Enter.
3. Select the disks to unassign as spares:
e To select all disks, press the A key.

e To select individual disks, use the arrow keys to highlight the disk and press Insert to
select it. Any number of disks may be selected using this method.

4. Press Enter to unassign the selected disks.
5. Press the C key to continue, or press the ESC key to return to the Main Menu.

5.5.7 View Disk Details

This option allows the user to view details about the disk. Nothing can be changed using this menu
option; it is for informational purposes only.

1. At the Main Menu, use the arrow keys to highlight View Disk Details, then press Enter.

2. Use the arrow keys to highlight a disk. Information about the disk is displayed in the
Information field across the top:

e Unique Disk ID
e Drive Type
e Cache Settings
e Maximum Free Space
e Model Number
e Serial Number
3. Press ESC to exit to the Main Menu.
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5.5.8 View Array Details

This option allows the details of the array to be viewed. Nothing can be changed using this menu
option; it is for informational purposes only.

1. Atthe Main Menu, use the arrow keys to highlight View Array Details, then press Enter.
2. Use the arrow keys to choose an array.
3. The full details of the array are displayed in the Information field across the top:

e Array number

e RAID level
e Size
e State

e (ache settings
Note: The disks in the array are selected (green).

5.5.9 Rescan All Channels

This option allows the user to rescan all channels to detect new or removed disks and arrays. It
rereads the configuration information from each disk.

Sometimes when a disk is offline, it can be brought online through a rescan.

1. At the Main Menu, use the arrow keys to highlight Rescan All Channels.
2. Press Enter.
3. The activity indicator in the Information field spins while the disks are being polled.

5.5.10  Change the Controller Options

Controller Options allows the user to configure options for the boot sequence.

Note: By default, all options are On. It is recommended that options remain On.

5.5.10.1 Booting the System from an Array

This option allows the user to enable boot support.

It is recommended that this option be disabled only if the system is booted from another device.

At the Main Menu, use the arrow keys to highlight Controller Options then press Enter.
Use the arrow keys to highlight Toggle INT13 Boot Support.

Press Enter to toggle between On and Off.

Press ESC to return to the Main Menu.

b=
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5.5.10.2 Pausing the Boot Sequence for Warning Messages

When the Pause feature is enabled and an array goes critical, offline, or there is another problem
with the system, the boot process stops and an error message is displayed on the screen. The user
must press Enter to continue booting.

If the Pause feature is disabled, error messages are briefly displayed as the system continues to
boot.

1. Atthe Main Menu, use the arrow keys to highlight Controller Options, then press Enter.
2. Set pauses to the boot sequence for critical warnings.
a. Use the arrow keys to highlight Toggle Pause if Critical.
b. Press Enter to toggle between On (enables pauses) and Off (disables pauses).
3. Set pauses to the boot sequence for offline warnings by doing the following:
a. Use the arrow keys to highlight Toggle Pause if Critical.
b. Press Enter to toggle between On (enables pauses) and Off (disables pauses).
4. Press ESC to return to the Main Menu.

5.5.10.3 Change the Staggered Spinup Count

Depending on a system’s power supply load-rating, the end-user might want to limit the number
of disks that are spun-up together when a system is powered on.

For example, if a system has six disks and the staggered spinup count is set to 2, RAIDXpert2
sends a command to spin-up disks 1 and 2 together, then disks 3 and 4, and finally disks 5 and 6.

1. At the Main Menu, use the arrow keys to highlight Controller Options, then press Enter.

2. Use the arrow keys to highlight Set Staggered Spinup Count, then press Enter. The number
within the brackets changes color to indicate it is selected.

3. Use the arrow keys to change the number within the brackets. The minimum is 1 and the
maximum is 8.

4. Press Enter to save the setting, or press ESC to return to the Main Menu.
5.5.11  Continue Booting from the BIOS Configuration Utility

After settings have been changed, continue booting the system from the point where the user
entered the RAIDXpert2 BIOS Configuration Utility.

5.5.11.1 Resume the Boot Process

1. At the Main Menu, use the arrow keys to highlight Continue to Boot.
2. Press Enter.
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Chapter 6 RAIDXpert2 Configuration Utility
(HII)

Before you begin, enable platform RAID mode by referring to Chapter 4, Platform RAID
Enablement Prerequisites, on page 36.

6.1 When to Use the RAIDXpert2 Configuration Utility
(HII)

The RAIDXpert2 Configuration Utility is also known as the HII. Use the utility to accomplish the
procedures indicated in Table 16.

Table 16. When to use the AMD-RAID RAIDXpert2 Configuration Utility (HII)

Procedure Description Find Information At

Initialize a new disk | To initialize a new disk drive for data storage. | Section 6.3, Initialize Disks, on page 50

Create Arrays Create arrays at different RAID levels Section 6.4, Create Arrays, on page 51
(depending on the license level for the system) | Section 6.5, Delete Arrays, on page 55

Delete Arrays Delete an array Section 6.5, Delete Arrays, on page 55

Manage hot spares | Allows selection of global and dedicated hot Section 6.6, Manage Spares, on page 55

spares.

View Controller View information about each controller. Section 6.7, View Controller Details, on

details page 56
Section 6.8, View Disk Details, on page
57

View Disk details View information about each disk. Section 6.7, View Controller Details, on
page 56

View Array details View information about each array. Section 6.8, View Disk Details, on page
57

Rescan all channels | Rescan all channels to detect new or removed | Section 6.10, Rescan All Channels, on
disks and arrays. page 58
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6.2 Access the AMD RAIDXpert2 Configuration Utility
(HII)

Note: The step(s) mentioned below is specific to AMD NDA BIOS.
AMD SP3-Series Chipsets BIOS is based on AMI BIOS:

To enter the RAIDXpert2 Configuration Utility (HII) Power on the system, then press DEL.
In the Menu Bar, select Advanced, select RAIDXpert2 Configuration Utility, then press Enter

AMD Socket AM4-Compatible Processor is based on Insyde BIOS:

To enter the RAIDXpert2 Configuration Utility (HII) Power on the system, then press ESC.
Select Device Management, then press Enter.
Select RAIDXpert2 Configuration Utility, then press Enter.

Note: If the BIOS Configuration Utility does not display, contact your system or motherboard
supplier.

6.3 Initialize Disks

New disks and legacy disks must be initialized before they can be used to create an AMD-RAID
array.

Initialization writes AMD-RAID configuration information (metadata) to a disk.

CAUTION: If a disk is part of an AMD-RAID array, the disk cannot be selected for initialization.
To initialize the disk anyway, delete the AMD-RAID array. Data on the disk is deleted
during initialization so ensure the correct disks are chosen to initialize.

CAUTION: 4 legacy disk can contain valid data. When a legacy array is deleted, all data on the
disk is lost.

1. At the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Physical Disk Management, then press Enter.

2. Use the arrow keys to select Select Physical Disk Operations, then press Enter.
3. Use the arrow keys to highlight Initialize Disk, then press Enter
4.  Select the disk(s) to initialize:

¢ To select individual disks, highlight a disk with the arrow keys and press the Space Bar or
Enter. Multiple disks may be selected using this method.

e When the desired number have been selected, use the arrow keys to select OK, then press
Enter.

e Review the warning message, if you want to proceed, use the arrow keys to select YES, then
press the Enter key, or press ESC to cancel the initialization.

50 RAIDXpert2 Configuration Utility (HII) Chapter 6



AMDA

53987 Rev.3.07 March 2018 AMD-RAIDXpert2 User Guide

Initialization takes 10 to 15 seconds per disk. During initialization, a complete rescan of all
channels is done automatically.

6.4 Create Arrays

Arrays can be created after the disks are initialized. See Section 3.2, RAID Levels, on page 26, for
deciding what type of RAID levels to use for the array.

TIP: See also Section 9.6.1, Create and Format Arrays on page 97, and Section 10.4, Create New
Arrays: rcadm --create, on page 118.

6.4.1 Before You Begin

¢ In some circumstances, more than eight arrays are possible. They might appear to
function properly, but are not supported by AMD-RAIDXpert2.

e For redundant arrays, the Create process starts after the operating system and AMD-
RAID OS drivers have been installed and the system has booted to the operating
system. However, the arrays are immediately available to use for either a bootable
array or a data array.

e Array numbers are valid only for a given boot, and might be different in the
RAIDXpert2 Configuration Utility (HII) and RAIDXpert2 Web GUI. If a permanent
label is required, use the RAIDXpert2 Web GUI Array Naming feature.

e At any point in the procedure, return to a prior window by pressing ESC.

e If the system is booted from an AMD-RAID bootable array, the first array in the
Arrays section must be the bootable array. The system boots only from the first array
in the Arrays section.

6.4.2 Create an Array

Note: The step(s) mentioned below are specific to AMD NDA BIOS. AMD SP3-Series Chipsets
BIOS is based on AMI BIOS. AMD Socket AM4-Compatible Processor is based on Insyde
BIOS.

Before proceeding with array create and manage, System BIOS configuration should be setup as
mentioned in Chapter 4, Platform RAID Enablement Prerequisites for system RAID mode to be
enabled

e The RAIDXpert2 Configuration Utility can be used to create a bootable array with
levels Volume, Raidable, RAIDO, RAID1 and RAID10. Configure array cache and Cache
tag size settings by following the steps mentioned in the sections below.
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Table 17. Default Cache Tag Size

Array Type Default CTS
HDD Array 64k
SSD Array
Mix of HDD/SSD Array
All NVMe Array 256k
Mix of NVMe with HDD/SSD Array 256k

Caution: Cache Tag Size cannot be changed for an array after creation.

To install the operating system and RAIDXpert2 files see Chapter 7, Software Installation, on
page 59.

6.4.2.1 Create an AMD-RAID Bootable Array
CAUTION: Do not use eSATA drives for bootable arrays as they are removable.

To install the operating system, AMD RAID Device driver and RAIDXpert2 Web-GUI utility
refer to Chapter 7, Software Installation, 59.

6.4.2.2 Create a RAIDABLE Array
Note: Refer to Table 7 for RAIDABLE array characteristics.

1. At the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter

2. Use the arrow keys to select Create Array, then press Enter.
3. Use the arrow keys to select Select RAID Level, then press Enter.

e From the Select RAID Level Drop down menu, use the arrow keys to select
RAIDABLE, then press Enter.

4. Select the disk with which to create the array:
e Use the arrow keys to select Select Physical Disks, then press Enter.

e Select an individual disk, highlight a disk with the arrow keys and press the Space Bar
or Enter.

e Use the arrow keys to select Apply Changes, then press Enter.

5. Please refer to Table 17 on page 52 for Default Cache Tag Size.

6. Using the arrow keys to select Read Cache Policy, then press Enter.
e Select the desired Read Cache Policy, then press Enter.

7. Using the arrow keys to select Write Cache Policy, then press Enter.
e Select the desired Write Cache Policy, then press Enter.

8. Use the arrow keys to select Create Array, then press Enter.
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6.4.2.3 Create a VOLUME Array
Note: Refer to Table 7 for VOLUME array characteristics

1. Atthe RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

2. Use the arrow keys to select Create Array, then press Enter.
3. Use the arrow keys to select Select RAID Level, then press Enter.

¢ From the Select RAID Level Drop down menu, use the arrow keys to select VOLUME,
then press Enter.

4. Select the disks with which to create the array:
e Use the arrow keys to Select Physical Disks, then press Enter.

e Select desired disks, highlight a disk with the arrow keys and press the Space Bar or
Enter.

e Use the arrow keys to select Apply Changes, then press Enter.

5. Please refer to Table 17 on page 52 for Default Cache Tag Size.

6. Using the arrow keys to select Read Cache Policy, then press Enter.
e Select the desired Read Cache Policy, then press Enter.

7. Using the arrow keys to select Write Cache Policy, then press Enter.
e Select the desired Write Cache Policy, then press Enter.

8. Use the arrow keys to select Create Array, then press Enter.

6.4.2.4 Create a RAIDO Array
Note: Refer to Table 7 for RAIDO array characteristics

1. Atthe RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

2. Use the arrow Kkeys to select Create Array, then press Enter.
3. Use the arrow keys to select Select RAID Level, then press Enter.

e From the Select RAID Level Drop down menu, use the arrow keys to select RAIDO, then
press Enter.

4. Select the disks with which to create the array:
e Use the arrow keys to Select Physical Disks, then press Enter.

e Select desired disks, highlight a disk with the arrow keys and press the Space Bar or
Enter.

e Use the arrow keys to select Apply Changes, then press Enter.

5. Please refer to Table 17 on page 52 for Default Cache Tag Size.

6. Using the arrow keys to select Read Cache Policy, then press Enter.
e Select the desired Read Cache Policy, then press Enter.

7. Using the arrow keys to select Write Cache Policy, then press Enter.
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e Select the desired Write Cache Policy, then press Enter.
8. Use the arrow keys to select Create Array, then press Enter.

6.4.2.5 Create a RAID1 Array
Note: Refer to Table 7 for RAIDI array characteristics

1. Atthe RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

2. Use the arrow keys to select Create Array, then press Enter.
3. Use the arrow keys to select Select RAID Level, then press Enter.

¢ From the Select RAID Level Drop down menu, use the arrow keys to select RAID1, then
press Enter.

4. Select the disks with which to create the array:
e Use the arrow keys to Select Physical Disks, then press Enter.

e Select desired disks, highlight a disk with the arrow keys and press the Space Bar or
Enter.

e Use the arrow keys to select Apply Changes, then press Enter.

5. Please refer to Table 17 on page 52 for Default Cache Tag Size.

6. Using the arrow keys to select Read Cache Policy, then press Enter.
e Select the desired Read Cache Policy, then press Enter.

7. Using the arrow keys to select Write Cache Policy, then press Enter.
e Select the desired Write Cache Policy, then press Enter.

8. Use the arrow keys to select Create Array, then press Enter.

6.4.2.6 Create a RAID10 Array
Note: Refer to Table 7 for RAID10 array characteristics

1. Atthe RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

2. Use the arrow keys to select Create Array, then press Enter.
3. Use the arrow keys to select Select RAID Level, then press Enter.

e From the Select RAID Level Drop down menu, use the arrow keys to select RAID10,
then press Enter.

4. Select the disks with which to create the array:
e Use the arrow keys to Select Physical Disks, then press Enter.

e Select desired disks, highlight a disk with the arrow keys and press the Space Bar or
Enter.

e Use the arrow keys to select Apply Changes, then press Enter.
5. Please refer to Table 17 on page 52 for Default Cache Tag Size.
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6. Using the arrow keys to select Read Cache Policy, then press Enter.
e Select the desired Read Cache Policy, then press Enter.

7. Using the arrow keys to select Write Cache Policy, then press Enter.
e Select the desired Write Cache Policy, then press Enter.

8. Use the arrow keys to select Create Array, then press Enter.

6.5 Delete Arrays

CAUTION: Deleting an array permanently destroys all data that is on the array. This action
cannot be undone and it is very unlikely the data can be recovered.

CAUTION: Do not delete the first array listed in the Arrays section, if it is the AMD-RAID
bootable array. Doing this deletes the operating system and AMD-RAID files.

6.5.1 Delete an Array

1.  Atthe RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

Use the arrow keys to select Delete Arrays then press Enter.
3. Select the array(s) to delete:

e Use the arrow keys to select the desired array or multiple arrays, then press the Space Bar
or Enter to change option to Enabled for deletion.

e If you want to select all of the arrays, use the arrow keys to select Check all, then press
Enter.

e Use the arrow keys to select Delete Array, then press the Space Bar or Enter.

e To select all the arrays for deletion: use the arrow keys to select Check all, then press the
Space Bar or Enter.

¢ Review the warning message, if you want to proceed, press the Space Bar or Enter.
e Use the arrow keys to select, Yes to Delete arrays or press the ESC key to exit.

6.6 Manage Spares

This option allows the user to assign or unassign global or dedicated spares.
Note: In order to assign a physical disk as a Global Spare, it must not be part of any Array.

6.6.1 Assign Global Spares

1. At the RaidXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Physical Disk Management, then press Enter.

2. Use the arrow keys to select Select Physical Disk Operations, then press Enter.
3. Use the arrow keys to select Select Physical Disk, then press Enter.
4. Use the arrow keys to select Assign Global Hot Spare, then press Enter.
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5. Review the warning message, if you want to proceed, use the arrow keys to select Yes or
press ESC or select No, to exit.

6.6.2 Assign Dedicated Spares

Note: Dedicated spares can only be assigned to redundant arrays and must the same size or
larger than the other members of the redundant array.

1. Atthe RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

2. Use the arrow keys to select Manage Array Properties, then press Enter.
3. Use the arrow keys to select Select Array.

e From the drop down menu, select the desired array (must be a redundant array), then
press Enter.

4. Use the arrow keys to select Manage Dedicated Hot Spares, then press Enter.
5. Select the disks to assign as dedicated spares.

e To select the disk, use the arrow keys to highlight the disk and press the Space Bar or
Enter to select it.

e Use the arrow keys to select Add Hot Spare Physical Disk, then press Enter.
e At the warning message, press the space bar or Enter to Confirm.

e Use the arrow keys to select Yes, then press Enter or press the ESC key to exit adding
the Dedicated Spare.

6.6.3 Unassign Spares

1. Atthe RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Physical Disk Management, then press Enter.

2. Use the arrow keys to select Select Physical Disk Operations, then press Enter.
3. Use the arrow keys to select Select Physical Disk, then press Enter.

4. From the drop down menu, use the arrow keys to select the Global / Dedicated Spare, then
press Enter.

5. Use the arrow keys to select Unassign Hot Spare, then press Enter.

6. Review the warning message, if you want to proceed, select Yes, then press Enter or press the
ESC key to exit.

6.7 View Controller Details

This option will display the details about of the controllers. Nothing can be changed using this
menu option; it is for informational purposes only.

1. Atthe RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Controller Management, then press Enter.

2. Use the arrow keys to select Select View Controller Information, then press Enter.
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3. Use the arrow keys to select Select Controller, then press Enter.
4. From the drop-down menu, select the desired controller, then press Enter.
5. Information about the controller is displayed below the Select Controller header:
e PCIID
e Controller Physical Disk Count
e Total Physical Disk Count
e Total Array Count
e UEFI Driver Version
e Firmware Properties/Firmware Build Time

6. To view another controller, press Enter and from the drop-down menu, select a different
controller, then press Enter.

7. Press ESC to exit to the Main Menu.

6.8 View Disk Details

This option allows the user to view details about the physical disk(s). Nothing can be changed
using this menu option; it is for informational purposes only.

1. At the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to highlight
Physical Disk Management, then press Enter.

2. Use the arrow Kkeys to select View Physical Disk Properties, then press Enter.
3. Use the arrow keys to select Select Physical Disk, then press Enter.

4. From the drop down menu, select the physical disk you want more information about, then
press Enter.

5. Information about the physical disk is displayed below the Select Physical Disk header:
e Unique Disk ID
e State
o Size
e Smart Status
e Revision
e Drive Type
e Maximum Free Space
e Used Space
e Disk Protocol
e Disk Speed
e Associated Array, if part of one
e Serial Number
e Model Number
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6. To view another physical disk, press Enter and from the drop down menu, select a different
physical disk, then press Enter.

7. Press ESC to exit to the Main Menu.

6.9 View Array Details

This option will display the details of an array. Nothing can be changed using this menu option; it
is for informational purposes only.

1. Atthe RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

2. Use the arrow keys to select Select Manage Array Properties, then press Enter.
3. Use the arrow keys to select Select Array, then press Enter.
4. From the drop down menu, select the desired array, then press Enter.
5. Use the arrow keys to select View Associated Physical Disks, then press Enter
6. Press the Space Bar to select one of the members of the Array
7. Use the arrow keys to select View Physical Disk Properties, then press Enter
8. Information about the array is displayed below the Select Array header:

e Array number

e RAID level

e State

e Size

e Cache Tag Size

e (Cache settings

e Associated physical disks
9. To view another array, press ESC twice and perform steps 2 through 8 again.
10. Press ESC to exit to the Main Menu.

6.10 Rescan All Channels

This option allows the user to rescan all channels to detect new or removed disks and arrays. It
rereads the configuration information from each disk.

Sometimes when a disk is offline, it can be brought online through a rescan.

1. Atthe RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Controller Management, then press Enter.

2. Use the arrow keys to select Rescan Disks, then press Enter.
e After a rescan completes, all of the physical disks will be displayed.
3. Use the arrow keys to select OK, then press Enter.
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Chapter 7 Software Installation

This chapter is designed to assist you with installation of Operating systems, by performing these
general procedures:

7.1 System Setup Process Overview

A generic system setup process follows these steps:

1. Copy the AMD-RAID drivers to a removable storage medium.
2. Power on the system.

3. To enable RAID on Refer to Chapter 4, Platform RAID Enablement Prerequisites, on page 36.
(This enables the loading of the AMD-RAID Option-ROM and or AMD-RAID UEFI driver).

4. Initialize the disks using the AMD-RAID Array Configuration Utility (HII) or AMD-RAID
Option-ROM.

5. Create arrays using the AMD-RAID Array Configuration Utility (HII) or AMD-RAID Option-
ROM.

6. Install the AMD-RAID drivers on the system.
7. Load the operating system.
8. Install the OS RAID Management Suite (AMD RAIDXpert2) on the system.

Note: To protect your data, always perform a backup prior to installing any new, major hardware
or software.

7.2 Before You Begin

Have the Windows® or Linux® operating system software available and ready to install.

7.3 Copying AMD-RAID Drivers to Removable Storage

You need to copy the drivers to a removable storage medium before you begin the installation.

7.3.1 Copying AMD-RAID Drivers in a Microsoft® Windows®
Environment

—

. Power on the system.

\S)

. Locate and use a system that is running a Windows operating system and has a CD DVD drive
or an I/O port for removable storage media (such as a USB flash drive).

(98]

Go to a browser and access the web site of your system supplier or motherboard vendor.

R

Insert the storage medium into the system:

e (Connect a USB flash drive to a USB I/O port or insert a blank CD-DVD disk into the
applicable drive.
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5.  Download the AMD-RAID drivers from the web site to the appropriate removable storage
medium.

7.3.2 Copying AMD-RAID Drivers in a Linux® Environment

1. Power on the system.

2. Locate and use a system that is running a Windows operating system and has a USB I/O port
for the USB flash drive.

3. Use a browser to access the web site of your system supplier or motherboard vendor.
4. Insert a USB flash drive into the USB I/O port of the system.

5.  Download the AMD-RAID drivers for the correct distribution version of Linux®. Copy the
drivers onto the USB flash drive:

e For Red Hat Linux: Copy the .iso image file (that matches the applicable distribution
of Linux to the USB flash drive . For example:

0 dd-rcraid-RHEL7-3.10.0-327.el7-x86_64.is0
e For Ubuntu: Copy the driver files contained inside the dd-rcraid-Ubuntu [Ubuntu
version number].w.x-yz-folder into a dd directory located on a root path of the USB
flash drive. For example:

o dd
e Jload amdraid
e post install
e post install2
e pre_install
e rcraid.ko
e rcraid generic.ko
e readme

7.4 Installing AMD-RAID Drivers

Follow the procedures below for Pre-install of AMD RAID Driver during Installation of your
Microsoft Windows or Linux® Operating System.

7.4.1 Installing AMD-RAID Drivers while Installing Microsoft® Windows®

7.4.1.1 Installing AMD-RAID OS Drivers during a Microsoft® Windows® 10
Installation

Note: The windows described in this procedure are typical. Path names and text can vary,
depending on user-designated selections and other parameters.

Note: NVMe devices are listed in the “Where do you want to install Windows? " do not delete any
of the partitions or format the devices. Doing so will delete the AMD-RAID metadata and
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the desired RAID level will be deleted. After AMD-RAID drivers have been loaded, a valid
AMD-RAID Virtual Disk appears.

b=

Power on the system.

Create a bootable array, refer to Section 6.4, Create Arrays, on page 51.

Insert the Microsoft Windows operating system media/disk into the system’s Optical drive.
Boot the system and allow it to access the Microsoft Windows operating system installation

media/disk.
5. At the Windows setup window:

Select the language, time, and keyboard options
Click Next.

Click Install Now or similar.

If prompted, select the desired Operating System
Click Next.

Depending on the installation window observed, choose one of the methods below to
load recbottom.inf

o0 Ifthe window observed is Select driver to install

e Insert the storage medium with the AMD-RAID drivers into the USB port or
applicable system drive

e Click Browse.

e Navigate to the directory containing the saved AMD-RAID drivers
e Click OK.

e Select the first rcbottom.inf driver in the list

e Click Next.

Note: If the installation has multiple controllers, there will be two or more rchottom.inf’s

listed, installation of rcbottom. inT is recommended only once.

0 Else follow onscreen prompt until Where to install Windows? window observed
e Select Load driver
e C(lick Browse.
e Navigate to the directory containing the saved AMD-RAID drivers
e C(lick OK.
e Select the first rcbottom.inf driver in the list
e C(Click Next.

6. At the Load Driver Window:

Click OK

Click Browse.

Navigate to the directory containing the saved AMD-RAID drivers
Click OK.

Chapter 7

Software Installation 61




AMDA
AMD-RAIDXpert2 User Guide 53987 Rev.3.07 March 2018

e Select the reraid.inf driver from the list
e C(lick Next.
7. Select (Check Mark) the I Accept the License Terms
e C(lick Next.
e Seclect Custom: Install Windows Only (advanced) or similar.

8. After both the rcbottom and rcraid drivers have been loaded, a valid Virtual disk appears in
“Where do you want to install Windows?”” window:

e C(Click Load Drivers
e C(Click Browse
e Navigate to the directory containing the saved AMD-RAID drivers
e C(Click OK
e Select the reefg.inf driver in the list
e C(Click Next
9. At the Where do you want to install Windows
e C(lick Next

10. Follow the on-screen instructions to complete the installation of the applicable Windows
operating system.

11. After the OS is installed, open Device Manager and verify the following:
e Expand Storage Controllers: there are entry(ies) listed as AMD-RAID Bottom Device
e Expand Storage Controllers: there are entry(ies) listed as AMD-RAID Controller
e Expand System Devices: there is an entry listed as AMD-RAID Config Device.

12. Remove the storage medium and Microsoft Windows OS CD-ROM or DVD from the
applicable drive(s) or port. Proceed to Section 7.6, Installing the AMD RAIDXpert2
Management Suite for Microsoft® Windows®, on page 76.

7.5 Installing the AMD RAIDXpert2 Management Suite
for Microsoft® Windows®

7.5.1 Windows® — AMD-RAIDXpert2 Management Suite

1. Obtain the latest Catalyst executable file from your system supplier or motherboard vendor.
Download the file to the system’s desktop, execute it and follow the on-screen prompts.

2. Click on the RAIDXpert2 Desktop Icon
e Select the applicable language from the drop-down menu (default is English)
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Chinese Simplified(CHS)
Chinese Traditional(CHT)
Danish{DAN)

German(DEU)

Spanish(ESN)
French{FRA)
Italian(ITA)
Japanese(JPN)
Korean(KOR)
Portuguese(PTG)
Russian(RUS)
Swedish({SVE

Default credentials are:
Username — admin
Password — admin

3. Change the credentials:

4. Re-log into the system with the new credentials.

7.5.2

Create new username

Create new password

AMD-RAIDXpert2 User Guide

Windows® — AMD RAIDXpert2 Management Suite Installation
(Manually)

Note: AMD RAIDXpert2 Management Suite installation default is a Silent installation.

1.

Obtain the AMD RAIDXpert2 Management Suite executable file (Setup.exe) from your
system supplier or motherboard vendor. Download Setup.exe to the system’s desktop.

Install AMD RAIDXpert2 (setup.exe):
a.
b.
C.
d.
Turn off Windows Firewall (or unblock during step 2).

Click on the RAIDXpert2 Desktop Icon

Select the applicable language from the drop-down menu (defaults on English)

Open a command prompt, must be run as Administrator
By typing e¢d C:\User\User_Name\Desktop

For silent installation: setup.exe
For GUI installation: setup.exe -i gui
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Chinese Simplified(CHS)
Chinese Traditional(CHT)
Danish{DAN)
German(DEU)

Spanish(ESN)
French{FRA)
Italian(ITA)
Japanese(JPN)
Korean(KOR)
Portuguese(PTG)
Russian(RUS)
Swedish({SVE

e Default credentials are:
i.  Username — admin

ii.  Password — admin

5. Change the credentials:
e. Create new username
f. Create new password
6. Re-log into the system with the new credentials.

See Section 9.1.1.1, Browser Setup, on page 87, for supported browsers and configurations.

7.5.2.1 Installing AMD-RAID BIOS Drivers during a Microsoft® Windows® 7
Installation

Note: The windows described in this procedure are typical. Path names and text can vary,
depending on user-designated selections and other parameters.

Note: Windows® 7 is supported only with RE-8.1 release. No NVMe support is available with
Windows 7.

1.  Power on the system.

Note: Do not boot up with a USB flash key in the system when performing an install, as the system
will use that as the boot device.

2. Create a bootable array by following the procedures in Section 6.4.2.1, Create an AMD-
RAID Bootable Array, on page 52.

3. Insert the Microsoft Windows operating system CD-ROM or DVD into the system's CD or
DVD drive.
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4.  Boot the system and allow it to access the Microsoft Windows operating system CD-ROM or
DVD.

5. At the Windows setup dialog box, do the following:
a. Select the language, time, and keyboard options, then click Next.
b. Click Install Now. If prompted, select the desired Operating System, then click Next.

c. Insert the storage medium with the AMD-RAID drivers into the USB port or applicable
system drive, then click Browse.

d. Navigate to the directory containing the saved AMD-RAID drivers, then click OK.
e. Select the rcbottom.inf driver from the list, then click Next..
Note: If the system has multiple controllers, there will be two or more rcbottom.inf’s listed.

6. At the Load Driver Window, do the following:

Click OK, Browse.

Navigate to the directory containing the saved AMD-RAID drivers, then click OK.
Select the reraid.inf driver from the list, then click Next.

Select the I Accept the License Terms checkbox, then click Next.

Select Custom: Install Windows Only (advanced) option.

Click Load Drivers, Browse.

Navigate to the directory containing the saved AMD-RAID drivers, then click OK.

Select the reefg.inf driver, then click Next. A valid drive displays at the Windows
installation location screen.

R A

Click Next, then follow the on-screen instructions to complete the installation.
8. Once the OS installation is complete, open Device Manager and verify the following:
e In the Expand Storage Controllers list, the AMD-RAID Bottom Device and AMD-RAID
Controller entries are displayed.
e In the Expand System Devices list, the AMD-RAID Config Device entry is displayed.

9. Remove the storage medium and Microsoft Windows OS CD-ROM or DVD from the
applicable drive(s) or port.

10. Proceed to Section 7.6, Installing the AMD RAIDXpert2 Management Suite for Microsoft®
Windows®, on page 76.

7.5.3 Installing AMD-RAID Drivers While Installing Linux® Operating
System

Note: The Linux® operating system modules must include the gCC+ compiler and the pthreads
library so that the ycadm program can be installed properly.

Note: Linux Operating System is supported only with RC-8.1 release. No NVMe support available
with Linux Operating System.
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7.5.3.1 Installing the AMD-RAID BIOS Drivers During a Red Hat Enterprise Linux®
7.3 64 bit (RHEL) Installation

Note: Prior to starting this procedure, obtain the AMD-RAID drivers from your system supplier or
motherboard vendor. Copy the AMD-RAID drivers to a USB flash drive, following the
instructions in Section 7.3.2, Copying AMD-RAID Drivers in a Linux® Environment, on
page 60 .

Note: When installing Red Hat Linux, use the Linux dd installation mode instead of the Linux
expert mode.

Note: Not all of the windows indicated in this procedure will appear during the installation.

Power on the system.

Insert the USB drive that contains the AMD-RAID drivers into the USB port.

Insert the Red Hat operating system CD-ROM or DVD into the system’s CD or DVD drive.
Create a bootable array by following the procedure in Section 6.4, Create Arrays, on page 51.

A

At the Red Hat Enterprise Linux welcome window, do the following:
a. Press the Up arrow, then select Install Red Hat Enterprise Linux 7.3.
b. Press Tab.

c. Type modprobe.blacklist=ahci inst.dd nomodeset at the end of the existing string then
press Enter. For example, vimlinux initrd.img.......quiet modprobe.blacklist=ahci
inst.dd nomodeset

6. At the Driver Disk Device Selection, press 1 (the number of the flash drive), then press
Enter.

7. At the Choose Driver Disk ISO file, press 1 (the number of the dd-rcraid-
RHEL....el7.2x86 64.is0 entry), then press Enter.

8. At Select Drivers to Install, do the following:

a. Press 1 (the number of the /media/DD/.....x86_64.rpm entry), then press Enter. The
/media/DD/... is selected and should look like [X] /media/DDy...... x86_ 64.rpm.

b. Press the C key, then press Enter.
9. At the Driver Disk Device Selection, press the C key, then press Enter.
10. At the Welcome to Red Hat Enterprise Linux Screen, do the following:
a. Choose the desired Language and Country.
b. In the bottom right corner, then click Continue.
11. At the Installation Summary Screen:
a. Under Localization, configure the following:
e Date and Time
e Keyboard
e Language Support
b. Under Software, configure the following:
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C.

12.

e Installation Source
e Software Selection
e Under Base Environments, select Server with GUI.

e Under Add-Ons for Selected Environments, select Compatibility Library.

e In the upper left corner, click Done.
Under System, configure the following:
e Installation Destination
e Under Local Standard Disks, select AMD-RAID Array.

e In the upper left corner, click Done.

e Network and Hostname
e In the bottom left corner, enter a valid Hostname.
e Sclect an Ethernet Port.
¢ In the bottom right corner, click Configure.
e Enter valid entries.
e Click Save.
e In the upper left corner, click Done.

In the bottom right corner, click Begin Installation.

13. At the Configuration window, do the following:

a.

Click Root Password:

e Enter an applicable root password.

e Re-enter the root password.

e In the upper right corner, click Done.
Click User Creation:

e Enter a Full Name.

e Enter a Username.

e Enter an applicable password.

e Re-enter the user password.

e In the upper right corner, click Done.

14. When the Installation Complete message displays, do the following:

a.

b

In the bottom right corner, click Reboot.

. Eject and remove the USB flash drive and the installation media.

15. At the Initial Setup of Red Hat Enterprise Linux Server 7.3, do the following:

a.

b
C.
d

Press 1, then press Enter.

. Press 2, then press Enter.

Press R, then press Enter.

. Press the C key, then press Enter.
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16. Login to the system and do the following:
a. Select a user.
b. Enter a password.
17. At the Welcome window, select the desired language, then click Next
18. At the Select Input Sources Window, select the desired Input Source, then click Next.
19. If desired, Configure Online Accounts, then click Next.
20. Click Start using Red Hat Enterprise Linux Server.
21. For RHEL 7.3 64 bit installs, manually load the following el7.686 rpms.
a. Allow the system to boot and login as root when prompted.
b. Insert the RHEL 7.3 x 64 installation CD/DVD into the system.
c. Install the following rpms:
o 1ibX11...el7.1686
e libXau...el7.1686
e libxcb...el7.1686
o libXext...el7.1686
e 1ibXi...el7.1686
o libXtst...el7.1686
o gtk2...... el7.1686
o libstdc++*.¢17.1686
o 1ibSM-*.el7.1686
e libpngl2*.el7.1686
e adwaita-gtk2-theme-*.el7.1686
e libcanberra-gtk2-*.e17.1686
e PackageKit-gtk3-module-*.el7.1686
22. Open a Web Browser, then do the following:
a. Go to rpmfind.net
b. Search for compat-libstdc++-33
c. Download and install the compat-libstdc++-33-3.2.3-71.e17.1686.rpm
d. Reboot the system.

7.5.3.2 Installing the AMD-RAID BIOS Drivers during a Supported Ubuntu Desktop
Installation

Note: AMD-RAIDXpert2 supports the Ubuntu 16.04 desktop operating systems.

Note: Prior to starting this procedure, obtain the AMD-RAID drivers from your system supplier or
motherboard vendor. Copy the AMD-RAID drivers to the dd directory on a USB flash drive,
following the instructions in Section 7.3.2, Copying AMD-RAID Drivers in a Linux®
Environment, on page 60.
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Note: The Ubuntu driver CD-ROM .iso image contains all Linux variations for a particular
release.

Note: Some of the windows indicated in this procedure might not appear during the installation.

1. Power on the system.
2. Remove the Ethernet cable from the system.

3. Insert the Ubuntu desktop operating system CD-ROM or DVD into the system's CD or DVD
drive.

Create a bootable array by following the procedure in Section 6.4, Create Arrays, on page 51.
As soon as the Ubuntu desktop kernel starts loading, press F6 to go to Advanced Options.
Select the desired language, then press Enter.

From the list, select Try Ubuntu without Installing

Press F6 - Other Options, then press ESC.

At the end of the Boot Options string, type the following, then press Enter: break=mount
modprobe.blacklist=ahci nomodeset

LN bk

Note: The string should look like the following: splash --- break=mount modprobe.blacklist=ahci
nomodeset

10. When the BusyBox shell displays, perform the following steps:
a. Insert the USB flash drive.
b. Type the following, pressing Enter after each one:
e mount -t vfat /dev/sdal /tmp

Note: /dev/sdal may need to be changed to /dev/sdbl or /dev/sdcl, depending on the number of
devices there are.

e cp-ap /tmp/dd/
/dd/pre_install
e umount /tmp

e cxit
c. Remove the USB flash drive.
11. Wait patiently for the Ubuntu Desktop to appear
12. Double Click the Install Ubuntu 16.04.1 LTS Desktop ICON
13. When the Welcome screen displays, select the desired language then click Continue.
14. From the Preparing to Install Ubuntu window, accept the defaults, then click Continue.

15. From the Installation Type window, Select Erase Disk and install Ubuntu, then click
Install Now.

16. From the Write Changes to Disks? window, then click Continue.
17. Select the desired time zone, then click Continue.

18. Select the desired keyboard layout, then click Continue.

19. Enter valid entries for the following, then click Continue.
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a. Your name
b. Computer name
c. User name
d. Password
e. Confirm Password
f. Click Continue

20. When the Installation Complete window displays, do the following:
a. Insert the USB flash drive.
b. Press CTRL + ALT + T.
c. Type the following, pressing Enter after each one:
e sudo mount -t vfat /dev/sdal /mnt
e sudo cp -ap /mnt/dd /
e sudo /dd/post_install

21. Wait for the Setup is Complete message, then press CTRL + D. Click Restart Now, to finish
the installation.

22. When prompted, remove the CD/DVD and USB flash drive from the system, then press Enter.
23. Reconnect the Ethernet cable.

24. Proceed to Section 7.7, Installing the AMD RAIDXpert2 Management Suite for Linux®, on
page 76.

7.5.3.3 Install the AMD-RAID UEFI Drivers during a RHEL 7.3 64-bit Linux®
Installation

Note: The Linux operating system modules must include the gcc+ compiler and the pthreads
library, so that the rcadm program can be installed properly.

Note: Prior to starting this procedure, obtain the AMD-RAID drivers from your system supplier or
motherboard vendor. Copy the AMD-RAID drivers to a USB flash drive. See Section 7.3.2,
Copying AMD-RAID Drivers in a Linux® Environment, on page 60.

Note: When installing Red Hat Linux, use the Linux dd installation mode instead of the Linux
expert mode.

Note: Not all of the windows indicated in this procedure will appear during the installation.

Power on the system.
Insert the USB drive containing the AMD-RAID drivers.
Insert the Red Hat operating system CD-ROM or DVD into the system’s CD or DVD drive.

Create a bootable array by following the procedures in Section 6.4.2.1, Create an AMD-RAID
Bootable Array, on page 52.

b=

5. At the Red Hat Enterprise Linux Welcome window:
a. Press the Up arrow.
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b. Select Install Red Hat Enterprise Linux 7.3 64 bit.
c. Pressthe E key.
d. Press the down arrow to the linuxefi /images entry
e. Press the END key.
f.  Add “modprobe.blacklist=ahci inst.dd nomodeset” to the end of the string

1. Example — linuxefi /images........ quiet modprobe.blacklist=ahci inst.dd nomodeset

6. Wait for the Driver Disk Device Selection to appear
a. Insert the USB drive (which contains the AMD-RAID drivers) into the USB port.
b. Press the r key
c. Press Enter
7. At the Driver Disk Device Selection,
a. Press 1 —the number of the flash drive
b. Press Enter.
8. At the Choose Driver Disk ISO file
a. Press 1 —the number of the dd-rcraid-RHEL....el7 x86_64.iso0 entry
b. Press Enter.
9. At the Select Drivers to Install
a. Press 1 —the number of the /media/DD/.....x86 64.rpm entry
b. Press Enter.

1. The /media/DD/... is now selected and should look like [X]
/media/DD/...... x86_64.rpm

c. Press the C key
d. Press Enter.
10. At the Driver Disk Device Selection
a. Press the C key
b. Press Enter.
11. At the Welcome to Red Hat Enterprise Linux Screen, do the following:
a. Choose the desired language and country.
b. In the bottom right corner, then click Continue.
12. At the Installation Summary Screen:
a. Under Localization, configure the following:
e Date and Time
e Keyboard
e Language Support
b. Under Software, configure the following:
e Installation Source
e Software Selection
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e Under Base Environments, select Server with GUI.
e Under Add-Ons for Selected Environments, select Compatibility Library.
¢ In the upper left corner, click Done.
c. Under System, configure the following:
e Installation Destination
e Under Local Standard Disks, select AMD-RAID Array.
¢ In the upper left corner, click Done.
e Configure Kdump
e Network and Hostname
¢ In the bottom left corner, enter a valid Hostname
e Select an Ethernet Port
¢ In the bottom right corner, click Configure.
e Enter valid entries.
e C(lick Save.
e In the upper left corner, click Done.
13. In the bottom right corner, click Begin Installation.
14. At the Configuration window, do the following:
a. Click Root Password
e Enter an applicable root password
e Re-enter the root password.
¢ In the upper right corner, click Done.
b. Click User Creation
e Enter a Full Name
e Enter a Username
e Enter an applicable password.
e Re-enter the user password.
¢ In the upper right corner, click Done.

15. At the Installation Complete window, click Reboot in the bottom right corner, then eject and
remove the USB flash drive.

16. At the Initial Setup Window
e C(lick License Information
e Review and Select (Check Mark) I accept the License Agreement
e If desired, Configure Subscription Management Registration
e Ifnot already configured, configure Configure Network & Hostname
e In the upper left corner, Click Done
e In the bottom right corner, Click Finish Configuration
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17. If a pop-up appears stating that the system has to reboot
e Click OK
18. Login to the system
e Select a user.
e Enter a password.
19. At the Welcome window,
e Select the desired Language
e C(Click Next

AMD-RAIDXpert2 User Guide

20. At the Typing — Select your Keyboard Layout or Input Sources Window

e Select the desired Input Source

e Click Next
21. If desired, Configure Online Accounts, then click Next.
22. Click Start using Red Hat Enterprise Linux Server.

23. For RHEL 7.3 64 bit installs, manually load the following el7.686 rpms:

a. Allow the system to boot and login as root when prompted.

b. Insert the RHEL 7.3 64-bit installation CD/DVD into the system.

c. Install the following rpms:

o 1ibX11...el7.i1686

e libXau...el7.1686

e libxcb...el7.i1686

e libXext...el7.1686

e 1ibXi...el7.i1686

e libXtst...el7.1686

o gotk2...... el7.1686

e libstdc++*.el17.1686

e |ibSM-*.el7.1686

e libpngl2*.el7.1686

e adwaita-gtk2-theme-*.el7.1686

e libcanberra-gtk2-*.e17.1686

o PackageKit-gtk3-module-*.el7.1686
24. Open a Web Browsr and do the following:
Go to rpmfind.net
Search for compat-libstdc++-33

a o o e

Reboot the system.

Download and install the compat-libstdc++-33-3.2.3-71.el7.i686.rpm
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7.5.3.4 Installing the AMD-RAID UEFI Drivers during a Supported Ubuntu Desktop
Installation

Note: AMD-RAIDXpert2 supports the Ubuntu 16.04 desktop operating system.

Note: Prior to starting this procedure, obtain the AMD-RAID drivers from your system supplier or
motherboard vendor. Copy the AMD-RAID drivers to the dd directory on a USB flash drive,
see Section 7.3.2, Copying AMD-RAID Drivers in a Linux® Environment, on page 60.

Note: The Ubuntu driver CD-ROM .iso image contains all Linux variations for a particular
release.

Note: Not all of the windows indicated in this procedure will appear during the installation.

1. Power on the system.
2. Remove the Ethernet cable from the system.

3. Insert the Ubuntu desktop operating system CD-ROM or DVD into the system's CD or DVD
drive.

4. Create a bootable array by following the procedure in Section 6.4.2.1, Create an AMD-RAID
Bootable Array, on page 52.

5. Boot to the Ubuntu desktop CD-ROM or DVD. This will bring you to the GNU GRUB
Window.

6. Select Try Ubuntu without installing

7. Press the E key to edit the commands before booting

8. Find the string that starts with linux /casper/vmlinuz.efi file=/cdrom.....splash --
e Press the END key

e At the end of the Boot Options string add the following: break=mount
modprobe.blacklist=ahci nomodeset
Note: The string should look like: splash --- break=mount modprobe.blacklist=ahci
nomodeset

e Press F10, to boot.

9. When the BusyBox shell appears perform the following:
Note: If the BusyBox shell doesn’t appear, reboot and try again.

e Install the USB flash drive

e Type: mount —t vfat /dev/sdal /tmp
Note: /dev/sdal may need to be changed to /dev/sdbl or /dev/sdcl ...depending on the
number of devices.

e Type: cp —ap /tmp/dd /
e Type: /dd/pre_install
e Type: umount /tmp
e Type: exit
e Remove the USB flash drive
10. Wait patiently for the Ubuntu Desktop to appear.
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11. Double click the Install Ubuntu 16.04.1 LTS desktop ICON
12. From the Welcome window
e Select the desired Language
e C(Click Continue
13. From the Preparing to Install Ubuntu window
e Accept the defaults
e C(lick Continue
14. From the Installation Type window
e Select Erase Disk and Install Ubuntu
e C(Click Install Now
15. From the Write Changes to Disks? Window
e C(Click Continue
16. Select the desired Time Zone
e C(lick Continue
17. Select the desired Keyboard layout
e C(Click Continue
18. Enter valid entries for the following:
e  Your name
e Computer name
e User name
e Password
e Confirm Password
e C(lick Continue
19. When the “Installation Complete” window appears, do the following:
o Install the USB flash drive
e Press CTRL+ALT+T
e Enter: sudo mount —t vfat /dev/sdal /mnt
e Enter: sudo cp —ap /mnt/dd /
e Enter: sudo /dd/post_install
20. Wait for the Setup is Complete
e Press CTRL+ALT+D
e Click Restart Now, to finish the installation.

21. The installation will prompt the user to remove the installation media, remove the CD/DVD
and USB flash drive from the system.

e When installation media has been removed
e Press Enter
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e Reconnect the Ethernet Cable

22. Proceed to Section 7.7, Installing the AMD RAIDXpert2 Management Suite for Linux®, on
page 76.

7.6 Installing the AMD RAIDXpert2 Management Suite
for Microsoft® Windows®

Obtain the latest Catalyst executable file from your system supplier or motherboard vendor.
Download the file to the system’s desktop and execute it. Follow the on-screen prompts.

See Section 9.1.1.1, Browser Setup, on page 87, for supported browsers and configurations.
7.7 Installing the AMD RAIDXpert2 Management Suite

for Linux®

Obtain the AMD RAIDXpert2 Management Suite executable file (Setup . sh) from your system
supplier or motherboard vendor. Download the Setup.sh file to the system’s desktop.

Table 18. Linux® Procedure for Installing the Management Suite

Element Action

Manually load the following 1686 rpms:
e libXl1l

e libXau

e libXcb

o libXext

o libXi

o libXtst

e compat-libstdc++
o gtk2

o libSM

e libpngl2

RHEL 7.3 64 bit

e adwaita-gtk2-theme
e libcanberra-gtk2
e PackageKit-gtk3-module.

For Ubuntu 16.04, 32-bit operating system, enter the following command
Ubuntu 16.04, 32-bit before executing Setup.sh:

operating systems only sudo In -s /1ib/i386-1inux-gnu/libc.so0.6
/1lib/libc.so.6
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Table 18. Linux® Procedure for Installing the Management Suite (Continued)

Element

Action

Ubuntu 16.04,
64-bit operating system
only

For the Ubuntu 16.04, 64-bit operating system, type the following
commands before executing Setup - sh, pressing Enter after each one:

sudo In -s /1ib/x86 _64-1inux-gnu/libc.so.6
/1lib/libc.so.6

sudo apt-get install 1ib32z1

sudo apt-get install lib32ncurses5

sudo apt-get install libxext6:i386

sudo apt-get install libxtst6:i1386

sudo apt-get install libxi6:1386

sudo apt-get install libstdc++6:1386

sudo apt-get install libgtk2.0-0:i386

sudo apt-get install libxxf86vml: 1386

sudo apt-get install libsm6:i1386

sudo apt-get install gtk2-engines-murrine:i386
sudo apt-get install libcanberra-gtk-module:i386

Setup.sh

Verify that the Setup . sh file is executable by right-clicking on the
Setup . sh file on the system’s desktop.

From the pop-up menu, select the Properties category.

Click the Permissions tab.

Permissions tab

Ensure that the Execute or Executable checkbox(es) is/are selected.
Click Close.

Setup.sh icon

Double-click the Setup - sh icon that is on the desktop.
At Do you want to run ‘Setup .sh’ or display its contents?, click Run.
Wait while Linux runs the Management Suite installer.

Introduction window

Click Next.

License Agreement
window

Select I accept the terms of the License Agreement.
Click Next.

What would you like to
install? window

Click Next.

Choose Install Folder Accept the default settings.
window Click Next.
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Table 18. Linux® Procedure for Installing the Management Suite (Continued)

Element Action

Choose Shortcuts window | Click Next.

Pre-Installation Summary | Review the selections.
window If they are okay, click Install.

Note: The Installing the AMD RAIDXpert2 Management Suite window
appears, showing the progress of the installation.

Install Complete window | Click Done.

7.8 Installing the AMD RAIDXpert2 Graphical User
Interface (GUI)

This section provides instructions for installing the AMD RAIDXpert2 GUI for Linux. For
information on using the GUI, see Chapter 9, AMD RAIDXpert2 Graphical User Interface (GUI),
on page 87.

7.8.1 RHEL Linux® — AMD RAIDXpert2 Web GUI Installation

1. Copy xampp-linux x64-7.1.6-0-installer.run to the system’s desktop
e Open a terminal / console window and cd to /root/Desktop. (or similar)
e Enter into Super User mode: su

e Enter: ./xampp-linux-x64-7.1.6-0-installer.run --mode unattended --disable-
components xampp_developer_files

2.  Enter:
e cd /opt/raidxpert2/htdocs
e Enter: cp —rv raidxpert2 /opt/lampp/htdocs
3. To start lampp, type the following, then press Enter:
e /opt/lampp/lampp startapache
Note: This must be done after each system reboot.
Note: rc_cgi and lampp must be running for the Web GUI to function correctly.
4. To start rcpopup, type the following, then press Enter:
e /opt/raidxpert2/bin/rcpopup &
Note: This must be done after each system reboot.

5. Click the RAIDXpert2 Desktop Icon
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6. Enter the following default credentials:
a. Username: admin
b. Password: admin

7.  Create a new username and password, and log into the system again with the new credentials.
7.8.2 Ubuntu — AMD RAIDXpert2 Web GUI Installation

1. Copy xampp-linux-x64-7.1.6-0-installer.run to the system’s Desktop.
e Open a terminal / console window and cd to /root/Desktop. (or similar)

e Enter: sudo./xampp-linux-x64-7.1.6-0-installer.run --mode unattended --disable-
components xampp_developer_files

2. Enter:
e cd /opt/raidxpert2/htdocs
e sudo cp —rv raidxpert2 /opt/lampp/htdocs
3. To start lampp, type the following, then press Enter:
e sudo /opt/lampp/lampp startapache
Note: This must be done after each system reboot.
Note: rc_cgi and lampp must be running for the Web GUI to function correctly.

4. To start rcpopup, type the following, then press Enter:
e /opt/raidxpert2/bin/rcpopup &
Note: This must be done after each system reboot

5. Click the RAIDXpert2 Desktop Icon.
6. Enter the following default credentials:
a. Username: admin
b. Password: admin
7. Create a new username and password, and log into the system again with the new credentials.
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Chapter 8 RAID Software Update

8.1 Purpose

This Chapter is designed to assist the user update their System to the latest released software.

This chapter describes the steps needed to update the AMD-RAID drivers installed on the
following Operating Systems:

e Microsoft® Windows® 7 32 bit and 64 bit

e Microsoft Windows 10 32 bit and 64 bit

e Red Hat Enterprise Linux® (RHEL) 7.3 64 bit

e Ubuntu Desktop Linux 16.04.1 32 bit and 64 bit

8.2 System Overview Process

A generic System update process is described below.

Backup the user data before doing any upgrade.

Power-on the System.

Log into the System.

Copy the AMD RAIDXpert2 Installer to the Systems Desktop.

Windows — Latest Catalyst from AMD — See 2.1 on page 18.
Windows — manual install, use Setup.exe — See Section 2.2 on page 18.
Linux — Setup.sh

5. Run the AMD RAIDXpert2 Installer to update the AMD RAIDXpert2 Management Suite.
6. Update the AMD-RAID OS drivers.
7. Restart the System.

IMPORTANT: To protect your data; always perform a backup prior to installing any new, major
hardware or software. If you are adding NVMe as RAID to your existing AMD-
RAID arrays, update all the existing AMD-RAID controller drivers to the latest
version and restart the system. Then connect the NVMe devices and install the
AMD-RAID driver onto NVMe devices.

b=
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8.3 Updating the AMD RAIDXpert2 Management
Suite.

8.3.1 Update the AMD RAIDXpert2 Management Application (Web
GUI)—Catalyst

1. Backup the user data before doing any upgrade.
2. Power-on the System.

3. Obtain the latest Catalyst executable file from your system supplier or motherboard vendor.
Download the file to the Systems Desktop and execute it. Follow the on-screen prompts.

8.3.1.1 Update the AMD RAIDXpert2 Management Application (Web GUI)—
Manually

1. Backup the user data before doing any upgrade.
2. Open a browser and access the Web Site of your system supplier or motherboard vendor.

3. Download the AMD RAIDXpert2 Installer (setup.exe) from the web site and copy it to the
Systems Desktop.

4. Open a Command Prompt terminal
Enter: cd \Users\user_name\Desktop
Enter: setup.exe -i silent

Note: The user must clear the Browser History of the Internet Browser being used by AMD
RAIDXpert2 Management Suite (Web GUI)

8.3.2 Copy the AMD RAIDXpert2 Installer to the Systems Desktop: Red
Hat Linux®

Power-on the System.
Go to a browser and access the Web Site of your system supplier or motherboard vendor.
Download the AMD RAIDXpert2 Installer (setup.sh) and copy it to the Systems / directory.

Open a console / terminal window and enter the following :

. ./setup.sh -1 silent cd /opt/raidxpert2/htdocs cp -rv
raidxpert2 /opt/lampp/htdocs

gk Lo =

Note: Enter — \cp —rv raidxpert2 /opt/lampp/htdocs to avoid answering y to all entries.

8.3.3 Copy the AMD RAIDXpert2 Installer to the Systems Desktop:
Ubuntu Linux®

1. Power-on the System.
2. Go to a browser and access the Web Site of your system supplier or motherboard vendor.
3. Download the AMD RAIDXpert2 Installer (setup.sh) and copy it to the Systems / directory.

Chapter 8 RAID Software Update 81



AMDZ\

AMD-RAIDXpert2 User Guide 53987 Rev.3.07 March 2018

e For Ubuntu 32-bit OS, enter the following commands before executing Setup.sh:
sudo In -s /1ib/1386-11nux-gnu/ libc.so.6 /Zlib/libc.so0.6

e For Ubuntu 64-bit OS, enter the following commands before executing Setup.sh:

sudo In -s /1ib/x86_64-1inux-gnu/ libc.so.6
/1ib/libc.so.6

b

Open a console / terminal window and enter the following

5. sudo ./setup.sh -1 silent cd /opt/raidxpert2/htdocs sudo cp -rv
raidxpert2 /opt/lampp/htdocs

Note: Enter — \cp —rv raidxpert2 /opt/lampp/htdocs to avoid answering y to all entries.

8.4 Updating the AMD-RAID OS Drivers — SOC and
AMD 300-Series Chipset

8.4.1 Windows® Drivers

8.4.1.1 Windows®—Catalyst

1. Backup the user data before doing any upgrade.
2. Ifnot already done, perform the steps in Section 7.4.1.1 on page 60.

8.4.1.2 Windows® 10—Manually

Backup the user data before doing any upgrade.
Open a browser and access the Web Site of your system supplier or motherboard vendor.
Download the AMD-RAID Drivers from the Web Site and copy it to the Systems C: drive.
Open Computer Management -> Device Manager.
Expand Storage Controllers.
Select the first AMD-RAID Bottom Device

¢ Right Click and select Update Driver Software

e C(Click Browse my computer for driver software.

AN e

o Click Browse, set the path to the Systems C drive.
e Click OK.
e Click Next
Note: if a Window Security Window pops up, select Install this driver software anyways.
e Click Close

e At System Settings Change pop up prompting the user to restart the system, Click No.
7. Select the first AMD-RAID Controller

e Right Click and select Update Driver Software
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e C(Click Browse my computer for driver software.
e Click Browse, set the path to the Systems C drive.
e Click OK
e C(Click Next
Note: if a Window Security Window pops up, select Install this driver software anyways.

e Click Close.

e At System Settings Change pop up prompting the user to restart the system, Click No
8. Expand System Devices.
9. Select AMD-RAID Config Device

e Right Click and select Update Driver Software

e Click Browse my computer for driver software.

e (lick Browse, set the path to the Systems C drive.

e Click OK

e C(Click Next

Note: if a Window Security Window pops up, select Install this driver software anyways.

e Click Close
10. Restart the System.

8.4.2 Linux® Drivers
8.4.2.1 RHEL

Insert a USB flash drive containing the AMD-RAID driver disk iso image.
Copy the dd-rcraid-RHEL7...86 64.iso file to the Systems Desktop
Right Click on the dd-rcraid-RHEL7....8x_64.iso and select Extract Here
In a terminal / console window and enter the following:
e cd /root/Desktop/dd-rcrald-RHEL7..x86 64/rpms/x86 64

e rpm -1 ——-force kmod-rcraid-6.0.0-3.10..rpm

b=

Note: If command doesn’t work, enter chmod 777 kmod-rcraid.....rpm

5. Wait for command to complete.
6. Reboot the System.
Note: remember to remove the USB Flash drive

8.4.2.2 Ubuntu

Warning: If the systems kernel has been updated, perform Section 3.2.2 before the system is
rebooted. Failing to do so may result in the system failing to boot.
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1. Open a terminal / console window.
a. Enter - uname -r

b. Document the kernel version. (i.e., —4.2.0-16-generic)
2. Open the Ubuntu Software Center
a. In the upper right corner, search for “kernel header v.w.x yz”
ii.Where v.w.x yz is the documented kernel version

b. Select all that relate to the Systems kernel version
c. Click Install
iii.Example: 4.2.0-16-generic

d. In the upper right corner, search for “build-essential”
e. Select “build-essential”
f. Click Install
3. Change directory to the RAIDXpert2 driver sdk directory and enter the following:
e cd /opt/raidxpert2/driver_sdk
e sudo ./install
Note: If command doesn’t work, sudo chmod 777 install.sh

4. Wait for command to complete.
5. Reboot the System.

8.4.3 Adding NVMe to Existing AMD-RAID System
8.4.3.1 Update Windows® 10 Drivers for SoC and AMD 300-Series Chipsets

1. Backup the user data before doing any upgrade
2. Ifnot already done, perform the steps in Section 8.3.1.1 on page 81
3. Ifnot already done, perform steps in Section 8.4.1.1 on page 82

8.4.3.2 Update Platform BIOS

1. Flash the BIOS with a version that supports AMD-RAID NVMe RAID
2. Enable RAID on the SOC, Promontory and NVMe

3. Save the BIOS settings

4. Power off the system

5. Install the NVMe devices

6. Power on the system

8.

4.3.3 Install the AMD-RAID Driver for NVMe

1. Open Device Manager.
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2. Expand Storage Controllers.
e Select the desired Standard NVM Express Controller
¢ Right Click and select Update Driver Software...
e C(Click Browse my computer for driver software.
e C(Click Let me pick from a list of available drivers on my computer
e C(lick Have Disk
e Click Browse, set the path to the Systems C: drive.
e From the list, select the rcbottom.inf entry
e C(Click Open
e Click OK
e C(Click Next
Note: If a Window Security Window pops up, select Install this driver software anyways.

e C(Click Close

e At System Settings Change pop up prompting the user to restart the system, Click
No.

3. Perform Step 2 for each additional NVMe device you want to run RAID.
4. Expand Other Devices
e Select the desired Unknown Device
Note: If you are unsure which entry to use, select an Unknown Device, Right Click and select
Properties. Click the Details Tab and the Device instance path should display rcbottom.
¢ Right Click and select Update Driver Software...
e (lick Browse my computer for driver software.
e Click Next
e C(Click Have Disk
e Click Browse, set the path to the Systems C: drive.
e From the list, select the reraid.inf entry
e C(Click Open
e Click OK
e C(Click Next
Note: If a Window Security Window pops up, select Install this driver software anyways.

e C(Click Close

e At System Settings Change pop up prompting the user to restart the system, Click No
5. Perform Step 4 for each addition NVMe you want to run RAID.
6. Expand Other Devices

e Select AMD-RAID Configuration SCSI Processor Device

e Right Click and select Update Driver Software...
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Click Browse my computer for driver software.

Click Let me pick from a list of available drivers on my computer
Click Next

Click Have Disk

Click Browse, set the path to the Systems C: drive.

From the list, select the rcefg.inf entry

Click Open

Click OK

Click Next

Note: If a Window Security Window pops up, select Install this driver software anyways.

Click Close
At System Settings Change pop up, Click No

Restart the System
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Chapter 9 AMD RAIDXpert2 Graphical User
Interface (GUI)

9.1 Start RAIDXpert2

RAIDXpert2 can be accessed using a web browser or Windows shortcut.

9.1.1 Web-Browser Access
9.1.1.1 Browser Setup

e Use Chrome version 20, Firefox version 14, Internet Explorer 8, or Safari 6, or a greater
version of each.

e To optimize the display, use a color monitor and set its color quality to the highest setting.

e To navigate beyond the Sign In page (with a valid user account):

0 Set the browser’s local-intranet security option to medium or medium-low. For
Internet Explorer 8, adding the controller’s network IP address as a trusted site can
avoid access issues.
0 Verify that the browser is set to allow cookies at least for the IP address of the
controller.
e To see the help window in Microsoft® Internet Explorer, you must enable pop-up windows.
9.1.1.1.1 Signing In Using a Web Browser
1. Inthe web browser’s address field, type the IP address of a controller network port and press
Enter.
2. The AMD RAIDXpert2 Management Tool Login is displayed. If the Login page does not
display, verify that you have entered the correct IP address.
3. On the Login page, enter the name and password of a configured user. The default user name
and password are admin and admin.

Note: Both usernames and passwords are case-sensitive.

4.  Select a language at the drop-down menu.

5. Click Submit. If the system is available, the RAIDXpert2 GUI page is displayed; otherwise,
a message indicates that the system is unavailable.

9.1.1.2 Tips for Signing In and Signing Out Using a Web Browser

e Do not include a leading zero in an IP address. For example, enter 10.1.4.33 not
10.1.4.033.

e Multiple users can be signed in to each controller simultaneously.

e For each active RAIDXpert2 session an identifier is stored in the browser. Depending
on how your browser treats this session identifier, you might be able to run multiple
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independent sessions simultaneously. Internet Explorer can run separate RAID Xpert2
sessions if you select File > New Session. If you do not select a new session, all
instances of Internet Explorer share the same session.

e End a RAIDXpert2 session by selecting Options > Logout. Do not simply close the
browser window.

9.1.2 Desktop Shortcut Access
9.1.2.1 Signing In Using the RAIDXpert2 Desktop Shortcut

1. Launch the AMD RAIDXpert2 Management Tool using by double-clicking the RAIDXpert2
desktop shortcut.

2. The AMD RAIDXpert2 Management Tool Login is displayed. If the Login page does not
display, verify that you have used the correct shortcut.

3. Select a language at the drop-down menu.

4.  On the Login page, enter the name and password of a configured user. The default user name
and password are admin and admin.

Note: Both usernames and passwords are case-sensitive.

5. Click Submit. If the system is available, the RAIDXpert2 GUI page is displayed; otherwise,
a message indicates that the system is unavailable.

9.2 Password Protection

When the system displays a window that prompts you to choose a username and password, use the
procedure below.

1.  In the Username field, enter the new username.

2. Inthe Password field, enter the new password. Follow the guidelines in Section 9.2.1, Things
to Know About Passwords, on page 88.

3. Inthe Confirm New Password field, re-enter the new password.
Note: Both usernames and passwords are case-sensitive.

4.  Click Submit.

9.2.1 Things to Know About Passwords

e RAIDXpert2 cannot be opened without a password. Create a password that is easily
remembered.

e The password must be 4 - 20 characters long.
e The password is case-sensitive.

e The application does not track previous passwords unless enabled through your web
browser.
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e To change an existing password, see Section 9.2.2, Change a Password at the Options
Menu, on page &9.

e Ifauser forgets the username or password, delete rc_login.txt to restore the default
user name and password (admin and admin).

9.2.2 Change a Password at the Options Menu

Note: Both usernames and passwords are case-sensitive.

1. At the Options menu, select Password.

2. The Choose a new Username and Password window displays.

3. Inthe Old Password field, enter the default password you used to login.

4. Inthe New Password field, enter the new password. Follow the guidelines in Section 9.2.1,
Things to Know About Passwords, on page 88.

5.  Inthe New Password field, re-enter the new password.

6. Click Submit.

9.3 Help and About Windows®

To view the software version and build number for the GUI, select About at the Help menu. The
AMD RAIDXpert2 Driver Version and GUI Version displays.

For customer support, select Help > User Guide. A pdf version of this document will display. A
pdf reader program will be necessary to view it.

For further customer support, contact your system supplier or motherboard vendor.

9.4 Reviewing the RAIDXpert2 GUI

9.4.1 The Array View Section of the Array Status Window

94.1.1 Elements of the Array View Section

The Array View section presents a graphical view of array properties. Table 19 provides
information about the elements of the Array View section.

Table 19. Elements of the Array View Section, Array Status Window

Element Description

Controller Name | The RAIDXpert2 controller for the arrays displayed below it.

Array The number assigned to an array.
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Table 19. Elements of the Array View Section, Array Status Window (Continued)

Element Description

Array name | The name assigned to an array.

RAID Level | The RAID level of the array.

Disk Number | The number assigned to disks in an array.

Disk . .

Manufacturer The manufacturer of disks in an array.
Disk Model The model number of the disks in an array.
Number

9.4.2 The Disk List Section of the Array Status Window
94.2.1 Elements of the Disk List Section

The Disk List section provides information about all disks assigned or available to arrays. Table
20 provides information about the elements of the Disk List section.

Table 20. Elements of the Disk List Section, Array Status Window

Element Description

Disk Disk number.

Capacity Disk capacity:

1 MB = 1,000,000 bytes

1 GB = 1,000,000,000 bytes

Note: Because the ATA storage industry has standardized the meanings of
MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2
reports the same units

Port Type Negotiated Speed (not the speed of the port type and SATA NCQ or NVMe
GS Indicates if the disk is assigned as a global spare.

State State of the disk (Online, Offline, SMART Error).

Type Disk type (Disk, Legacy, New).

State State of the disk (Online, Offline, SMART Error)
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Table 20. Elements of the Disk List Section, Array Status Window (Continued)

Element Description
Model Disk manufacturer’s model number.
Serial No. Disk manufacturer’s serial number.
Firmware Disk manufacturer’s firmware version.
Space Available Total amount of space unused on the disk.
Largest Available Largest contiguous unused space on the disk.
Features Information about port communication and physical disk cache settings.

If a disk is missing from the Disk List, the most likely cause is:

e A loose cable. Make sure that all disk cables are connected, then perform a rescan.

e A disk that is not fully seated in its bay or slot. Make sure that the disk is inserted
completely in its bay or slot, then perform a rescan.

For more information, see Section 9.5.2, Rescan Disks, on page 95.

9.4.3 The Array List Section of the Array Status Window
9.4.3.1 Elements of the Array List Section

The Array List section provides information about the arrays. Table 21 provides information about
the elements of the Array List section.

Table 21. Elements of the Array List Section, Array Status Window

Element Description

Device The array number.

Drive letter that was assigned to this array during the partition process. (A
blank space appears if the array has not been partitioned.)

Partiti
arttion Note: If a dynamic volume is created on an array, RAIDXpert2 cannot
retrieve the volume’s drive letter.
Array Name User-created name for the array.
Type The RAID level (RAID type) or LEGACY.
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Table 21. Elements of the Array List Section, Array Status Window (Continued)

Element Description
Total capacity:
1 MB = 1,000,000 bytes
Total Capacity 1 GB = 1,000,000,000 bytes . . .
Note: Because the ATA storage industry has standardized the meanings of
MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAID Xpert2
reports the same units.
State State of the array (NORMAL, CRITICAL, OFFLINE).
Task Task type, if in progress (TRANSFORM, CHECK, CHECK BITMAP,
CREATE, RESTORE, ZERO, SECURE ERASE).
The state of the task (STARTED, PAUSED, COMPLETED); the progress
Task State L . .
of the task is given in the Array View section.
Pri Task priority if a task is in progress.
Scan Background Array Scan enabled? (Yes/No).
Cache Current cache setting (NC = No Cache, R = Read Ahead Cache, W = Write
Back Cache, RW = Read/Write Cache).
. Any Array with only HDD/SSD will have default CTS of 64k
Cache Tag size ; .
Any Array with NVMe/HDD/SSD will have default CTS of 256k

9.4.4 The Event View Section of the Array Status Window
9.4.4.1 Elements of the Event View Section

The Event View section is an optional-view section. It can be displayed or hidden by selecting
View > Event View.

The information in the Event View is linked to the View Log. The View Log displays user-
initiated tasks or actions, and system-generated notifications and events. The View Log can be
accesses by selecting View > Log.

The Event View provides information about the events. Table 22, on page 93, provides
information about the elements of the Event View section.
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Table 22. Elements of the Event View Section, Array Status Window

Element Description
# The number of the event.
Date The date and time at which the event occurred.
Event The RAIDXpert2 Asynchronous Event Notification (AEN) number of the event.
Priority The notification priority of the event: Low, Informational, Warning, Critical, or Fatal.
Text A brief description of the event.
9.4.5 Array and Disk Commands

The Array and Disk menus of the Array Status window contain lists of commands. The commands
allow the system user to initiate or modify array- and disk-related tasks.

Not all commands are available for an array or for the system. Availability depends on:

The tasks that can be performed with the system’s license level.

The RAID level of an array. For example, a Consistency Check can be performed only
on arrays at a redundant RAID level.

The remaining capacity of the disk drives. For example, if a system has three disk
drives and large arrays have used all of the capacity on two of the disks, only non-
redundant Volume arrays can be created on the remaining disk. Certain commands are
not available with a non-redundant array.
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Table 23 provides page numbers for each command.

Table 23. Commands at the Array and Disk Menus

Rev. 3.07 March 2018

See Detailed See Detailed
Array Commands Information Disk Commands Information
on this Page on this Page
Create page 97 Initialize page 94
Name page 99 Rescan page 95
Transform page 100 Properties page 95
Prepare to Remove page 103 Options page 96
Delete page 104
Modify Cache Settings page 105
Task page 106
Check Consistency page 106
Background Array Scan page 108
Remove Spares page 108
Hide page 109
Secure Erase page 109
9.5 Working with Disks

9.5.1

Initialize Disks

When a disk is initialized, RAIDXpert2 configuration information (metadata) is written to the
disks. If a disk is new and has not been used before, or if it is a legacy disk, it must be initialized
before it can be used in a RAIDXpert2 array. After a disk is initialized, it appears as Disk in the
Disk List.

Note: A/l new disks and legacy disks will have an associated array. You must delete the array in
order to initialize the disk.
9.5.1.1 To Initialize Disks

1. At the Disk menu, select Initialize. The Initialize Disk window displays.
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2. Select the disk(s) to be initialized, by selecting the box next to the disk(s).
3. Click Initialize Selected.

9.5.2 Rescan Disks
The Rescan Command Performs the Following Actions:

e Rescans the SATA channels that search for new, legacy, or removed disks.
e Rereads the configuration information from each disk.

When a disk is offline, it might be brought online by using a rescan. A rescan also stops and then
automatically resumes all tasks.

To rescan disks, select Rescan at the Disk menu.

9.5.3 Change Cache Properties for Disks

The Read Ahead and Write Back Cache properties can be changed if the disks support this option.
The default settings are:

e Read Ahead: enabled.
e Write Back Cache: enabled.

CAUTION: Leaving Write Back Cache enabled can increase the likelihood of data being
corrupted if the system experiences a power interruption or unexpected shutdown.

Note: 4 disk’s cache setting cannot be changed if a task is active for the array. The cache settings
are enabled when the task is finished.

Note: As default setting NVMe Physical disk Read ahead and Write Back cache is always
disabled. User cannot enable the setting as it may impact the operational performance of the
NVMe disk.

9.5.3.1 Change Disk Caching Properties

1. At the Disk menu, select Properties.

2. The Properties window opens.

3. Select the disks you want to change the properties of.
4.  Click Enable or Disable for the desired settings.

Note: Each time Enable or Disable is clicked, the disk selection clears. To change multiple
settings on one disk, select the disk before clicking each setting.
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9.5.4 Assign Spares

Spare disks allow an array to be rebuilt when a disk fails. Global spares can be used in any array,
while dedicated spares are assigned to a specific array.

9.5.4.1 Assign a Disk as a Dedicated or Global Spare
1. In the Disk List section, select a disk.

2. At the Disk menu, select Options.

3. Options for Disk Device displays in the Disk List panel.

4. Perform one of the following actions:

e To use the disk as a dedicated spare, select Assign as Dedicated Spare.

Note: The capacity of a dedicated spare must be equal to or larger than the capacity of the
smallest disk in the array.

e To use the disk as a global spare, select Assign as Global Spare.
5. Click Confirm.

9.5.5 Legacy Disks
A legacy disk is a disk that contains valid data from a non-RAID controller.

A legacy disk appears in RAIDXpert2 (and in the BIOS Configuration Utility / RAIDXpert2
Configuration Utility (HII)) with a corresponding legacy array. When the legacy disk is initialized
in RAIDXpert2 (or in the BIOS Configuration Utility / RAIDXpert2 Configuration Utility (HII)),
the legacy array disappears.

CAUTION: 4 legacy disk can contain valid data. When a legacy array is deleted the data is lost.
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9.5.5.1

Table 24 provides information on how disks appear in RAIDXpert2 web utility and in the BIOS

Configuration Utility.

Legacy Disk and New Disk

AMD-RAIDXpert2 User Guide

Table 24. New and Legacy Disks, as They Appear in the BIOS Configuration Utility /
RAIDXpert2 Configuration Utility (HII) and RAIDXpert2

Status of the Disk

RAIDXpert2 Web Utility

In the BIOS Configuration
Utility/RAIDXpert2
Configuration Utility (HII)

New, un-initialized disk.

The disk appears as a new disk
with a legacy array.

When the new disk is
initialized, its state changes to
Online (or similar).

The disk appears as a new disk
(the disk can appear with a
legacy array).

When the new disk is
initialized, RAIDXpert2
configuration data is written to
the disk. The disk state changes
to Online.

A disk containing non-
RAIDXpert2 configuration
data.

CAUTION: 4 legacy disk can
contain valid data. When a
legacy array is deleted, or
when its corresponding legacy
disk is initialized, the data is
lost.

The disk appears as a legacy
disk with a legacy array.
When the legacy array is
deleted, the legacy array
disappears and the legacy disk
type changes to Disk. The disk
can now be used in
RAIDXpert2 arrays.

The disk appears as a legacy
disk with a legacy array.
When the legacy array is
deleted the state of the legacy
disk changes to Empty. The
disk can now be used in
RAIDXpert2 arrays.

See Chapter 9, AMD RAIDXpert2 Graphical User Interface (GUI), on page 87, for the disk
initialization procedure and the appearance of legacy disks in the BIOS Configuration Utility.

9.6

9.6.1

Working with Arrays

Create and Format Arrays

RAIDXpert2 allows the partitioning and creation of as many as eight arrays across the system’s

disks. Portions of disks can be used to create arrays, at the same time that other arrays use different

portions of the same disks.

9.6.1.1

Review the issues and recommendations indicated in Table 25.

Before You Begin...
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Table 25. Creating Arrays: Issues and Recommendations

Issues Recommendations
Access to arrays The creation of arrays, even redundant arrays, allows users immediate
access to the arrays (unless the Zero Create option is used during the Create
process).
Array numbers Array numbers are valid only for a given boot, and can be different in the

BIOS Configuration Utility and RAIDXpert2. If a permanent label is
required, use the Array Naming feature described in Section 9.6.2, Name
Arrays, on page 99.

Array size The array size of the new array is limited to 2.199 TB on some versions of
Windows and Linux. Refer to the operating system documentation for
details on maximum array sizes.

Number of arrays In some circumstances, more than eight arrays are possible. They might
appear to function properly, but are not supported by AMD-RAID.

System reboot When the system reboots, the creation process continues where it left off.

9.6.1.2 Create an Array

9.6.1.2.1 Select an Array and Cache
1. Atthe Array menu, select Create.

2. Select the disk(s) to include in the array by checking the box next to the desired disk(s) in the
Select Active Disks: field.

Note: Click All to select all disks, or click Unused to select disks that are not currently used in an
array. Maximum of 8 NVMe/HDD/SSD disks can be part of array. if more than 8 disks, the
Create button will be grayed out or unselectable.

3. Enter a name for the array in the Array Name: field.
Note: The following characters are not allowed in an array name

4.  Select an array type at the Array Type: drop-down menu.
5. Atthe Organized As: drop-down menu select an option.

Note: The Organized As: drop-down menu only displays options for advanced management of a
RAID10 configuration if you selected RAID10.

6. Enter the capacity in the Capacity: field. The maximum available capacity changes with:

98 AMD RAIDXpert2 Graphical User Interface (GUI) Chapter 9



AMDA

53987 Rev.3.07 March 2018 AMD-RAIDXpert2 User Guide

e The disks that are selected.
e The RAID level of the array.

7. Select a cache option at the Cache Options: drop-down menu. (The default is Read and Write
Back Cache.)

8. Cache Tag Size will default to a setting based off of the disks that are selected. All HDD/SSD,
default will be 64k. All NVMe or a mix of NVMe/HDD/SSD will default to 256k. The user
should not change from the default settings.

9.  Check Background Array Scan to enable background array scanning. (A background array
scan checks the sectors of the disks in an array for potential problems. A background array
scan runs continuously, until the user stops it by accessing Array > Background Array Scan >
Stop).

Note: Please refer to Table 17 on page 52 for Default Cache Tag Size.
Note: See Section 9.6.12, Scan an Array in the Background, on page 108, for details.

10. Check Skip Initialize to skip initialization.

CAUTION: Creating a redundant array with Skip Initialization selected can result in data
corruption.

11. Check Leave Existing Data Intact if an array is lost or deleted, and the user immediately
creates a replacement array of the same characteristics. This leaves the data on the disks of
the lost or deleted array untouched when the replacement array is created. See Table 44, on
page 134, for additional information.

12. Check Zero Create to write zeros on the created array. If Zero Create is used, the array is not
immediately available (the array is hidden from the operating system during the Create
process).

13. Click Create to create the array.

9.6.1.3 Partition and Format an Array

Each operating system has different names and paths for partitioning and formatting arrays and as
such are outside the scope of this document. For more information, see your operating system’s
user documentation.

9.6.2 Name Arrays

Naming an array can be useful when creating backups. It makes an array easy to identify in a list
of arrays.

1. Inthe Array View section, select the array to name.
2. Atthe Array menu, select Name. The Array Name window displays.
3.  Type the desired name in the blank field.

Note: The following characters are not allowed in an array name:

Chapter 9 AMD RAIDXpert2 Graphical User Interface (GUI) 99



AMDZ\

AMD-RAIDXpert2 User Guide 53987 Rev.3.07 March 2018

4. Click OK. The array name appears in the Array List and in the BIOS Configuration Utility
(only 17 characters of the name are displayed in the BIOS Configuration Utility).

9.6.3 Transform Arrays
With the Transform task, an array can be:

e Transformed from one RAID level to almost any other RAID level. This function is
also referred to as Online RAID Level Migration (ORLM).

e Expanded dynamically, even under I/O load, by adding disks to the array to increase
the capacity of the array. This function is also referred to as Online Capacity
Expansion (OCE).

9.6.3.1 Before You Begin
Review the issues and recommendations indicated in Table 26.

Table 26. Transforming Arrays: Issues and Recommendations

Issues Recommendations

Array size An array cannot be transformed to a smaller-sized array. The transformed
array must be the same size as or larger than the original array.

Array size limits The array size of the transformed array is limited to 2.199 TB on some
versions of the Windows and Linux operating systems. Refer to the
operating system documentation for details on maximum array sizes.

Disk failure during a | If a disk fails while the Transform task is in progress, no data is lost as long
Transform as the source and destination RAID levels are redundant. If a spare has been
assigned to the destination array, a fail-over task starts as soon as the
Transform completes (if the spare is available after the Transform).

Multiple arrays If there are multiple arrays, it might not be possible to transform some of the
arrays to a larger size. If, in the future, an array needs to be expanded in
size, it is best to configure the available space as a single array.
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Table 26. Transforming Arrays: Issues and Recommendations (Continued)

Issues Recommendations
Task control When using task control commands, a Transform task can only be paused or
commands resumed but not removed. To end a Transform task, pause and delete it.

Note: If a task is paused and then deleted, the array is deleted. Deleting a
task is the same as deleting an array. Data loss occurs when a task is
deleted. Please ensure that data is backed up prior to deleting a task
involving a Transform or a Restore.

System reboot during | If the system reboots during a Transform, the Transform continues where it

a Transform left off.

9.6.3.2 Transform an Array

1. Inthe Array View section, select the array to transform.

2. At the Array menu, select Transform.
Note: If the system window is not wide enough, only the Destination View is displayed.

3. Select all the desired disks for the array (including disks that might be already in the array)
by selecting the box next to the drive in the Disk List section.
Note: Click Same to select all disks currently used in the array, All to select all disks, or

Unused fo select disks that are not currently used in an array.
4.  Select the RAID level to be transformed at the Array Type: drop-down menu.
5.  Atthe Organized As: drop-down menu select an option.

Note: The Organized As: drop-down menu only displays options for advanced management of a

6.

RAID10 configuration if you selected RAID10.

Expand the array by entering the size of the new array in the Capacity: field. The maximum
available capacity changes with:

e The disks that are selected.
e The RAID level of the array.

Note: If a Transform is not possible, the Commit option is not enabled. A typical reason
preventing a Transform is insufficient available space on the disks.

Click Commit.

Note: Unless the transformation is instantaneous, the Array Status window updates to show
the source and destination arrays, along with the progress of the transformation.
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9.6.3.3 Access Additional Space

After an array has been transformed to a larger size, use the operating system tools to access the
additional space.

There are several possible methods for expanding the existing file system on an array that has been
transformed to a larger size:

e Microsoft provides a command prompt utility called Diskpart.exe that can expand any
NTES file system without requiring a reboot. The Diskpart.exe utility version to use
depends on the version of Windows being run. The Diskpart.exe utility can be found
on the CD that comes with some versions of Windows, or at the Microsoft website
(http://'www.microsoft.com) for others. Use the correct version for the operating
system.

e For arrays formatted with FAT32, use a third-party application, such as
PartitionMagic from PowerQuest Corporation.

9.6.4 Restore (Rebuild) Arrays

With the Restore task, a redundant-type array whose state has changed to Critical can be restored
(rebuilt) in one of two ways:

e By assigning a dedicated spare to the array.

e By creating a global spare or by using an existing global spare. (An existing global
spare automatically starts restoring a redundant-type array after the array’s state
changes to Critical.)

An array in an Offline state cannot be restored. This means that non-redundant arrays (Volume,
RAIDO0) cannot be restored: when a single disk in a non-redundant array fails, the array state
changes to Offline.

Note: If a Critical redundant array that is being restored loses a second disk (RAID1), or loses a
second disk in the same mirror set (RAID10), the Restore task fails. The array must be re-
created from backup storage data.

9.6.4.1 Before You Begin

e Make sure that the disk chosen as the dedicated spare or global spare has sufficient
available capacity to restore the array. The capacity of the spare disk must be equal to
or larger than the capacity of the smallest disk in the critical array.

e Know how to create a global or dedicated spare. See Section 9.6.13, Add or Remove
Dedicated Spares, on page 108 or Section 9.6.14, Add or Remove Global Spares, on
page 109.

9.6.4.2 Restore a Critical Array

1. Inthe Array View section, select the critical array.
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2. At the Disk List section, double click on a disk.

3. At the Disk menu, select Options. Options for Disk Device displays in the Disk List panel.
Perform one of the following actions:

e To use the disk as a dedicated spare, select Assign as Dedicated Spare.

e To use the disk as a global spare, select Assign as Global Spare.
4.  Click Confirm.

9.6.5 Prepare to Physically Remove an Array
9.6.5.1 Physically Remove an Array

CAUTION: Prior to removing an array, remove its drive letter (Windows) or unmount the array
(Linux).

1. Inthe Array View section, select the array to remove.
At the Array menu, select Prepare to Remove.

hadlig

At the Prepare to Remove window, click Yes. The array and all associated disks disappear
from the Array Status window.

Remove the first disk from the system.
When the Drive Removed window displays, click Cancel.

4

5

6. Remove the remaining disks in the array.

7. When all disks in the array are removed from the system, select Rescan at the Disk menu.
9.

6.5.2 Array Migration

The disks in an array, after being removed from one system with a RAIDXpert2 controller, can be
migrated to another system with a RAIDXpert2 controller. The disks and array(s) appear in the
second system, in Disk Management, the BIOS Configuration Utility, and RAIDXpert2, as normal
RAIDXpert2 disks and array(s).

If the disks from a RAIDXpert2 system are migrated to a non-RAIDXpert2 Windows-based
system, the disks appear in Disk Management of the second system as healthy, unknown
partitions. To use the disks, use Disk Management to delete the RAID Xpert2-created partitions
and to create Windows partitions on the disks.

CAUTION: 4ll data contained in a RAIDXpert2 array are lost if the RAID Xpert?2 disks of the
array are migrated to a non-RAIDXpert2 system.
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9.6.6 Delete Arrays

CAUTION: Deleting an array permanently destroys all data that is on the array. This action
cannot be undone and it is very unlikely the data can be recovered.

9.6.6.1 Before You Begin
Review the issues and recommendations indicated in Table 27.

Table 27. Deleting Arrays: Issues and Recommendations

Issue Recommendation
Drive letters or Remove drive letters or partitions from the array using procedures in your
partitions operating system. Each operating system has different names and paths for

removing drive letters or partitions and as such are outside the scope of this
document. For more information, see your operating system’s user

documentation.
Operating system If the array is not being used by the operating system, the array can be
impact on arrays deleted at any time, even while tasks are running on the array.

If the array is being used by the operating system, the array cannot be
deleted. Therefore, a RAIDXpert2 bootable array cannot be deleted in
RAIDXpert2. A RAIDXpert2 bootable array can only be deleted in the
BIOS Configuration Utility.

9.6.6.2 Delete an Array

1. Inthe Array Status window, select the array to delete.
2. Atthe Array menu, select Delete. A windows opens, warning about deleting the array.
3. Click OK. The array disappears from the Array View section.

Note: Also see Section 10.5, Delete Arrays: rcadm --delete, on page 119.

9.6.6.3 Recreate a Deleted Array

If an array is deleted, it might be possible to recreate the array. See Table 44. Recreate a Deleted

Array, on page 134.
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9.6.7 Change Cache Settings for Arrays
Table 28 provides information about the four array-caching options available.

Table 28. Cache Array Options

Option Description

No Cache I/O requests are translated and passed to the disks without keeping a cached
copy of the data available for future requests

Read Cache Data reads are cached, if appropriate. This option performs sequential Read
Ahead, when necessary

Write Back Cache Data writes are cached. This setting is intended for advanced users who
understand the implications of Write Back caching

Read + Write Back Both Read and Write Back Cache options can be selected
Cache (default setting)

Note: Cache options cannot be changed while a task is active on the array. They can be changed
at any other time, including while I/O is running.

9.6.7.1 Change Cache Settings

1. Inthe Array View section, select the array on which to change caching options.
2. Atthe Array menu, select Modify Cache Settings.

3.  Choose No Cache, Read Cache, Write Back Cache, or Read + Write Back Cache. The
new cache setting displays in the Array List Cache information.

9.6.8 Change the Priority Level of a Task

The task priority command allows the user to speed up or slow down tasks being performed on
arrays.

To decrease the amount of time it takes for a task to complete, set the task priority higher (10 is
the highest).

Note: A4 task priority can only be changed after a task is running on the array.
9.6.8.1 Change a Task Priority

1. Inthe Array View section, select the array on which tasks are being performed.
2. Atthe Array menu, select Task and select Priority.
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3. Atthe Task Priority window, change the task priority by moving the slide one way or the
other.
4.  Click OK.
9.6.9 Interrupt, Cancel, or Resume a Task

The task control commands allow the user to pause, resume, or cancel (remove) tasks being
performed on arrays.

Full task control can be used on Create, Consistency Check, and Check Bitmap tasks. On Restores
with dedicated or global spares the task can be removed, but the array returns to the Critical state.

Note: Task control can be used only when a task is running on an array.
9.6.9.1 Interrupt, Cancel, or Resume a Task

1. Inthe Array View section, select the array on which a task is being performed.
2. Atthe Array menu, select Task then click:

e Pause to interrupt the task.

e Remove to cancel the task.

e Resume to interrupt the task.

9.6.10  Check for Consistency

For redundant-type arrays only, the Consistency Check task is available at the Array menu. When
this task is selected it starts the process of verifying that the mirror drive consistency for fault-
tolerant disks is correct. If inconsistent areas are found, they are corrected during this process.

Having consistent arrays is very important. If an array is inconsistent and a drive fails, data is lost.
RAIDXpert2 is designed to maintain consistent arrays, but it is good practice to run frequent
consistency checks. See Section 9.6.11, Schedule a Consistency Check, on page 107.

When a redundant array is created using the Create command, and the Skip Initialize option is not
checked (the default setting), a Consistency Check is performed automatically. Although a
Consistency Check that runs during a Create task can be removed (by highlighting the array and
selecting Task > Remove), the array that is created is not redundant. Unless a Consistency Check
runs from end-to-end, an array is not protected.

After a Consistency Check has been started, adjust the priority of the Consistency Check task
relative to user I/O activity. Use the Task Priority option (see Section 9.6.8, Change the Priority
Level of a Task, on page 105).

A Consistency Check task can be scheduled with the Schedule Consistency Check task (see
Section 9.6.11, Schedule a Consistency Check, on page 107).
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9.6.10.1 Before you Begin

e The Consistency Check command can be started at any time on a redundant-type
array, as long as another task is not running on the array.

e The Consistency Check command can be started while under 1/0 load.
e Ifthe array state is Critical, the Consistency Check fails.

e To estimate the remaining time for a Consistency Check, look at the percentage of the
task that is completed (in hours: minutes: seconds). These details are displayed next to
the array in the Array View section of the Array Status window.

9.6.10.2 Manually start a Consistency Check

1. Inthe Array View section, select the array on which to run the Consistency Check.
2. Atthe Array menu, select Check Consistency.
3. Click Start.

9.6.10.3 Manually stop a Consistency Check

1. Inthe Array View section, select the array on which to stop the Consistency Check.
2. Atthe Array menu, select Check Consistency.
3. Click Stop.

9.6.11  Schedule a Consistency Check

A Consistency Check task can be scheduled for later in the day or week. A Consistency Check
task can be scheduled to run each week or each month.

Note: Schedule only one Consistency Check event on an array. This means that if a monthly check
has been scheduled and a weekly check is desired, delete the monthly event and schedule the
new event.

Table 29 provides information on the available scheduling options for a Consistency Check.

Table 29. Consistency Check Options

Option Description

One Time Only Schedule the Consistency Check for the current day (“Today”) or up to
seven days in the future.

Weekly Events can be scheduled weekly. After it is selected, a Consistency Check
runs on the specified array at the same time each week.

Monthly Events can be scheduled to run once per month to run on the specified array
at a specified time.
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9.6.11.1 Schedule a Consistency Check for Later
1. Inthe Array View section, select the array on which to run the Consistency Check.
2. Atthe Array menu, select Check Consistency.
3. Select Schedule.
4. At the Check Consistency window, select the Frequency, Day, and Time, then click
Confirm.
9.6.11.2 Delete a Scheduled Consistency Check

In the Array View section, select the array to on which to delete the Consistency Check.
At the Array menu, select Check Consistency.

Select Schedule.

4. At the Consistency Check window, click Remove.

wonoe

9.6.12  Scan an Array in the Background

A Background Array Scan task performs a continuous background read operation of an array,
accessing at least one copy of every block of the array from beginning to end.

A Background Array Scan is manually started by the user and runs continuously until the user
stops it.

Although a Background Array Scan can run while an array is engaged in other tasks, it is
recommended that the Background Array Scan run while the array is idle (that is, when there is no
I/O to or from the array).

9.6.12.1 Enable or Disable a Background Array Scan

1. Inthe Array View section, select the array to on which to run the Background Array Scan.
2. Atthe Array menu, select Background Array Scan.
3. Enable or disable the Background Array Scan.
e To enable a Background Array Scan, select Start.
e To disable a Background Array Scan, select Stop.
Note: A Background Array Scan can also be enabled for an array when it is created.

9.6.13 Add or Remove Dedicated Spares
If a dedicated spare is added, make sure there is adequate space on the dedicated spare.
9.6.13.1 Add a Dedicated Spare

1. Inthe Array View section, select the array on which to assign a dedicated spare.
2. Inthe Disk List section, double click on the disk chosen as the dedicated spare.
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3. At the Disk menu, select Options.
4.  Select Assign as Dedicated Spare, then click Confirm.

9.6.13.2 Remove a Dedicated Spare Assignment

1. Inthe Array View section, select the array from which to remove a dedicated spare.

2. At the Disk menu, select Options.

3.  Select Remove as Dedicated Spare, then click Confirm.

TIP: For additional information see Section 3.10, Sparing Options: Disks and Arrays, on page 33.

9.6.14 Add or Remove Global Spares
If a global spare is being added, make sure there is adequate space on the global spare.
9.6.14.1 Add a Global Spare

1. Inthe Disk List section, select the disk chosen as the global spare.
2. At the Disk menu, select Options.
3. Select Assign as Global Spare, then click Confirm.

9.6.14.2 Remove a Global Spare

1. Inthe Disk List section, select the disk to be removed as the global spare.
2. At the Disk menu, select Options.
3. Select Remove as Global Spare, then click Confirm.

9.6.15 Hide an Array
Hide allows the user to hide the array from the operating system.
9.6.15.1 Hide an Array

1. Inthe Array View section, select the array to hide.
2. At the Array menu, select Hide. The array will disappear from the Array View.
Note: If the array is currently hidden, select Array > Un-hide to display it.

9.6.16 Secure Erase

Secure Erase is used for erasing all data on an array and ensuring that it will be unrecoverable,
even with advanced data recovery techniques.

Data is Securely Erased By:

e Hiding the array from the OS
e Writing over each region of the disk with 3 patterns (0xAA, 0x55, and random)
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e Using a 4th pass with all zeros to ensure that a RAID1 will be consistent

After the secure erase is complete, a user can choose to manually delete the array or reuse it. If the
user chooses to reuse it, it must be unhidden using the procedure in Section 9.6.15, Hide an Array,
on page 109.

CAUTION: When an array is securely erased, the data on the array is lost.
9.6.16.1 Securely Erasing an Array

1. Inthe Array View section, select the array to erase.
2. Atthe Array menu, select Secure Erase, then click OK.

9.7 Working with Views

The View menu allows the user to:

e Display the event view.
e Display the event log.
e Refresh the display.

9.7.1 Display or Hide Controller Event Log Panel

To display or hide the Controller Event Log, select Event View at the View menu. When the
Controller Event Log panel displays, a checkmark appears next to the Event View option at the
View menu.

9.7.2 Log Window

The [system name]: View Log window displays all of the messages generated by RAIDXpert2.
All messages are logged, not just the ones enabled at Options > Notification.

All messages received from the RAIDXpert2 driver are sent to a message log file. If desired,
change the name of this file in the Notification window.

By default, notification events in Windows-based systems are saved to:

%Program Files%\RAIDXpert2\rc_service.log.

Notification events in Linux-based systems are saved to /var/log/rc_service.log.
At the View menu, select Log to view the RAID Xpert2 messages.

9.7.3 Refresh the Display

To refresh the display, select Refresh at the View menu.
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9.8 Working with Options

9.8.1 Change Password Settings

A password can be changed at the Options menu. See Section 9.2.2, Change a Password at the
Options Menu, on page 89.

9.8.2 Set Event Notifications

With the Notification option, the user can manage event log and email notifications of events.

The Event View section of the Array Status window displays the priority listing. The event log
priority levels, in ascending order, are indicated in Table 30.

Table 30. Event Log Priority Levels

Event Priority Description

Low Displays messages for normal system operations. (This event is not
displayed unless requested by the user.)

Informational Displays information that might be useful to know.

Warning The system user should to be informed about this event, but probably does
not need to take action.

Critical The system user must be informed about this event and should take action.
Fatal The RAIDXpert2 driver is fatally damaged and the RAID subsystem has
shut down.
9.8.2.1 Set or Change Event Notifications

1. At the Options menu, select Notification. The Notification Setup window opens.

2. Specify the Outgoing Mail Server (SMTP) and To Email Address, to which e-mail
messages are sent when an event occurs.

3. Ifthe SMTP server requires a login, check the Server Required Login box and enter a valid
Username and Password for the server.

4.  Specify a user address as the sender of the e-mail notifications in From Email Address. (By
default, the system on which RAIDXpert?2 is installed is used.)

5. Click Send Test Message to verify that the e-mail notification works.

6. To disable messaging, uncheck the Enable Messaging check box in the Notification Events
section.

7. Choose the types of notification events to use (Email or Event Log) for each event priority
(Low, Informational, Warning, Critical, Fatal) by selecting the appropriate options.
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Note: Warning, Critical, and Fatal events will always display in the Event Log.

9.8.3 Licensing

To display Licensing information, including available licensing levels, select License at the
Options menu.

9.9 Add Spares Using a RAIDABLE Array
Note: RAIDABLE array is formerly known as RAID Ready array.

1. Install a new disk. After a rescan, a pop-up window opens.

Note: To create a redundant RAID1 array, the new disk must be the same size or greater than the
RAIDABLE disk.

2. Inthe Select a Disk section, select the new disk.
3. Inthe Choose a Task section, select the desired option.
Note: Selecting any option first initializes the disk before the selected task is started.

a. Backup Array: This option creates a backup of the RAIDABLE array on the new disk.

b. Transform Array: This option allows the user to either add space to the RAIDABLE
array or create a redundant array.

c. Initialize Disk for AMD-RAID: This option allows the disk to be used when creating
arrays.

d. Make disk a Global Spare: This option assigns the new disk as a global spare.
4. In the Select a Source/Destination section:

a. Select the Source RAIDABLE Array from the drop-down menu.

b. Select the Destination Array Type from the drop-down menu.

Note: The Destination Array Type option is only available when either the Backup Array task or
Transform Array task is selected. Only valid array types for the number of disks inserted will
be displayed. For example, if one new disk is inserted, only RAID0O or RAID1 will display in
the drop-down menu.

5. Click Confirm.

If either the Backup Array task or Transform Array task is selected, a Task Progress dialog box
opens. To hide the dialog box while the task is executing, click Close.
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Chapter 10 rcadm Command Line Interface
Tool

10.1 What is rcadm?

The rcadm program is a command line interface (CLI) tool for managing RAIDXpert2 in the
Windows, Linux, or EFI operating system. See Section 10.8, on page 120, for rcadm.efi
Information.

The rcadm program initiates RAIDXpert2 operations, such as:

e Manage RAIDXpert2, arrays and disks (see Section 10.2, Manage Arrays and Disks: rcadm --
manage, on page 114).

e Create new arrays (see Section 10.4, Create New Arrays: rcadm --create, on page 118).
e Delete arrays (see Section 10.5, Delete Arrays: rcadm --delete, on page 119).
e Transform arrays (see Section 10.6, Transform Arrays: rcadm --transform , on page 120).

e Follow or monitor arrays and disks (see Section 10.7, Follow or Monitor Arrays and Disks:
rcadm --follow, on page 120).

e Information on drive and array states.

The rcadm program has five primary modes, with most primary modes having additional optional
arguments. The five modes of operation are indicated in Table 39.

Table 31. Modes for the rcadm Program

Mode Usage

Manage Uses the rcadm --manage command to manage and query RAIDXpert2,
arrays, and disks.

Create Uses the rcadm --create command to create a new array.

Delete Uses the rcadm --delete command to delete arrays.

Transform Uses the rcadm --transform command to transform an array.

Follow Uses the rcadm —--follow command to follow or monitor arrays and disks.

Follow these instructions to issue the command on the operating system. Also, see Section 10.3,
View Help from the Command Line, on page 118.
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10.1.1  To Use rcadm with a Linux® Operating System
By default, rcadm is installed in Zusr/bin.

10.1.2  To Use rcadm with a Windows® Operating System

e Change directories to %Program Files%\RAIDXpert2.
e Run the rcadm.exe command from there.

or
o Add%Program Files%\RAIDXpert2 to the system or user path environment
variables.
10.2 Manage Arrays and Disks: rcadm --manage

The rcadm --manage or rcadm -M command allows the user to view information about
RAIDXpert2 and manage the arrays and disks.

For example, the user can:

e Set cache attributes for arrays.

e Set priority levels for tasks on an array.
e Hide and unhide arrays.

e List arrays.

e Initialize disks.

e Query information about disks.

e Add and remove spares from an array.

e Set cache attributes for disks.
10.2.1  Understand Query Output

When the rcadm --manage --query-all or rcadm -M -ga command is used,
information about the disks and arrays for the system is displayed.

To see information about a specific controller, disk, or array use the rcadm --manage --
query command, in conjunction with the appropriate options.
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10.2.2 rcadm Controller List Elements

Table 32. rcadm Controller List Elements

AMD-RAIDXpert2 User Guide

Element

Description

Number

Controller number assigned by RAIDXpert2

Type

Model number of the controller

Serial Number

Serial number of the controller

Port Count The number of ports supported by RAIDXpert2
PCIe® Vendor ID The PCle vendor identification number
PCle Device ID The PCle device identification number

PCle SubVendor ID

The PCle sub-vendor identification number

PCle SubDevice ID

The PCle sub-device identification number

SAS Address (WWID)

The SAS Address (world-wide identification number)

BIOS Version

The version of the AMD-RAID Configuration BIOS
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10.2.3

rcadm Disk List Elements

Table 33. rcadm Disk List Elements

Element Description
Disk Disk number assigned by RAIDXpert2, corresponding to the SATA
channel ID.
State State of the disk (Online, Failed, Unknown)
Disk Type Disk type (Disk, Legacy, New, ATAPI)
Port Type Port type (SATA, SATA 11, eSATA, SSD, NVMe)
Port Speed The negotiated speed of the port
Note: For NVMe the port type is always N/A.
Size Total size of the disk:
e 1 MB = 1,000,000 bytes
e 1 GB=1,000,000,000 bytes
Note: Because the ATA storage industry has standardized the meanings of
MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2
reports the same units.
Free Space Total amount of space unused on the disk

Largest Free Space

Largest contiguous unused space on the disk

GS Indicates if the disk is assigned as a global spare

Ca Current disk cache setting (NC = No Cache, R = Read Cache, W = Write
Back Cache, RW = Read + Write Back Cache).
Note: For NVMe the CA is always NC.

Ctrl Chan Disk controller and channel number.

Vendor Disk vendor

Model Number Disk model number

Firmware Version

Disk firmware version

Serial Number

Disk serial number
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10.2.4  rcadm Array List Elements

Table 34. rcadm Array List Elements

Element Description
A Array number assigned by RAIDXpert2
Type RAID type.
0.S. Name Name assigned by the operating system to the array. The name shows as

“Hidden” if the array is hidden from the operating system. The name
shows “??” if the array is Offline.

Sys or System Device | Indicates whether or not the array is being used as a system disk under

Windows
State State of the array (Normal, Critical, Offline)
Size or Capacity Total size of the disk:

e 1 MB = 1,000,000 bytes
e 1 GB=1,000,000,000 bytes
Note: Because the ATA storage industry has standardized the meanings of

MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2
reports the same units.

Hide Whether the array is hidden from the operating system

Id Globally unique identifier for the array assigned by RAIDXpert2

Task Task type (Transform, Check, Check Bitmap, Not Active, Create,
Restore)

Note: See Section 3.7, Array Tasks: Starting and Stopping Tasks, on page
30 for detailed definitions.

Task State The state of the task (Started, Paused, Completed)

% The progress of a current array task, such as a Create or Transform, shown
as percent complete

CA Current array cache setting (NC=No Cache, R=Read Cache, W=Write Back
Cache, RW=Read + Write Back Cache).
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Table 34. rcadm Array List Elements (Continued)

Element Description

CTS Cache tag size specifies the amount of data per disk in a stripe. Supported
sizes are 64kB, 128kB or 256kB

Any Array with only HDD/SSD will have default CTS of 64k
Any Array with NVMe/HDD/SSD will have default CTS of 256k

Scan Background scan enabled (Yes/No)
Name User-supplied name for the array
Dedicated Spare Indicates the number of dedicated spares assigned to the array

(--verbose mode only)

Disk Listing of disks that are part of the array
Used Capacity used of a specific disk
Offset Location on the disk where the array begins

10.3 View Help from the Command Line

10.3.1 To view a List of the Major Modes of Operation
Type: rcadm --help or rcadm -?

10.3.1.1 To View Help for a Specific Mode and its Options
Type: rcadm <mode> --helpor rcadm < mode> -?

For example, typing rcadm --manage --helpor rcadm -M -? displays help and
examples regarding that specific mode and its options.

10.3.1.2 To view the rcadm Man Page on a Linux® System

Type: man rcadm

10.4 Create New Arrays: rcadm --create

The rcadm --create or rcadm -C command allows new arrays to be created. As many as
eight arrays can be partitioned and created across all disks.
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Portions of disks can be used to create arrays, while other arrays are using different portions of the
same disks. A maximum of eight arrays can be created.

10.4.1  Before You Begin...

Creation of arrays, even redundant arrays, allows users immediate access to the arrays. If the
system reboots, the creation process continues where it left off.

CAUTION: In some circumstances, more than eight arrays are possible. They might appear to
function properly, but are not supported.

Note: The array size of the new array is limited to 2.199 TB with some operating systems. Refer to
the operating system documentation for details on maximum array sizes.

Note: The ability to create RAID10 or RAIDABLE arrays may not be available on your system.
10.4.2 Example

To create a 1 GB RAIDI array using disk members 1, 2, and 3, type: rcadm -C -rl -d 1 2
-s 1000

To see more examples, type: rcadm -C -7

10.5 Delete Arrays: rcadm --delete

The rcadm --delete or rcadm -D command allows the user to delete one or more arrays.

CAUTION: Deleting an array permanently destroys all data that is on the array. This action
cannot be undone and it is very unlikely the data can be recovered.

10.5.1  Before You Begin...

e If the operating system is using an array it cannot be deleted.

e [Ifan array is accidentally deleted, and the user wants to try and recover the data,
create an array using the same disks, same size, and same cache, and use the --leave-
existing-data option. This option writes new configuration information to the array
while trying to use the exact same disk space as before.

10.5.2  Example
To delete array 1, type: rcadm -D -a 1

To see more examples, type rcadm -D -7
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10.6 Transform Arrays: rcadm --transform

The rcadm --transform or rcadm -T command allows the user to transform (migrate) an

array from one RAID level to almost any other RAID level, and to expand the array dynamically,
even under I/O load.

10.6.1  Before You Begin...

e An array cannot be transformed to a smaller-sized array. New arrays must be either
the same capacity or larger.

e  When using the task control option, a Transform can only be paused or resumed but
not removed.

e Ifa spare has been assigned to the destination array, a fail-over task starts as soon as
the Transform completes, provided the spare is available after the Transform.

e [f there are multiple arrays on a single controller, it might not be possible to transform
some of the arrays to a larger size. If the size of an array might be expanded in the
future, it is best to configure the available space as a single array.

e The array size of the transformed array is limited to 2.199 TB on some operating
systems.

10.7 Follow or Monitor Arrays and Disks: rcadm --
follow

The rcadm --followor rcadm -F command allows the user to follow or monitor arrays
and disks. It polls the RAID subsystem for any changes in status and sends an e-mail notification
and/or executes a specified program. The output of this command is logged to the System Event
Log on Windows.

10.7.1  Before You Begin...
It is recommended that the user not run more than one instance of rcadm --follow at the same time.

If the user runs more than one instance of the command, each instance captures some of the events
but no single instance captures all events.

10.8 rcadm.efi Information

10.8.1 rcadm -?
-?, --help

Displays all primary rcadm commands, or if used after an option, displays help for that
specific option.
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-log, --log-file

Print output to a log file as well as standard output. Requires a log file name argument.
Overwrites existing file. Only one occurrence of this option on the command line is allowed.

Example: rcadm -M -qa -v -log status.txt

-C, --create

Command for creating arrays. Array types include linear (JBOD), volume (JBOD), RAIDO,
RAID1, RAID10, RAID10n, and RAIDABLE. Some of the major functions include assigning
spare disks; setting array size; and setting cache attributes.

-D, --delete

Command for deleting arrays. This mode does not have any optional arguments.
-M, --manage

Commands for managing and querying controllers, arrays, and disks. Some of the major
functions include querying for information, adding and removing dedicated and global spare
disks, setting cache attributes for arrays and disks, performing consistency checks on
redundant array types, initializing disks, prioritizing tasks for arrays, scanning arrays and disks
for changes in status, and hiding or unhiding arrays.

10.8.2 rcadm -M

MANAGE
-a, --array
Used with certain options to specify arrays.
-as, --add-spare
Adds a dedicated spare disk to an array. No space is reserved on the disk selected.
-rs, --remove-spare

Removes a dedicated spare disk from an array.

-ras, --remove-all-spares

Removes any spares from an array.
-ags, --add-global-spare

Adds a disk as a global spare. No space is reserved on the disk selected.
-rgs, --remove-global-spare

Removes a global spare disk.
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-ca, —--cache-array

Sets the cache attributes for an array. Cache attributes include read cache (r), read and write-
back cache (rw), write-back cache (w), and no cache (nc).

-cd, --cache-disk

Sets the cache attributes for a disk. Cache attributes include read cache (r), read and writeback
cache (rw), write-back cache (w), and no cache (nc).

-d, —--disk

A required qualifier used with certain options to specify disks.
-h, --hide

Hides an array from the operating system.
-uh, --unhide

Unhides an array, making it visible to the operating system.
-id, —--initialize-disk

Initializes a disk. If the disk is new and has not been used, you must initialize it before you can
create arrays.

-n, --name

Identifies an array with a user-supplied name. The name can be up to 30 characters, but only
17 of those characters display in the BIOS.

-p, —-priority

Sets an array's task priority from 1-10, with 10 being the highest priority.
-4, --query

Lists information about specific controllers, arrays, and disks.
-gqa, --query-all

Lists information about controllers, arrays, and disks.

-v, --verbose

Modifier of the --query and --query-all option. Specifies more detail for arrays and disks.

-I'sSc, --rescan

Rescans the serial ATA (SATA) channels for new or removed disks.

-sa, —--scan-array <on|off>

Specifies if background array scan scanning is on or off.
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-sp, —--smart-poll

Turns SMART polling on or off for the specified drive(s).

-t, --task

Used to pause, resume, and remove tasks.

-ul, —--unlink

Unlinks two arrays linked through a create copy operation.

SYNTAX and EXAMPLES
ADD SPARE
--add-spare --array <list> --disk <list>
-as —a <list> -d <list>
Examples: rcadm --manage --add-spare --array * --disk 1
rcadm -M -as -a 12 -d 56

REMOVE SPARE

--remove-spare --array <list> --disk <list>
-rs -a <list> -d <list>

Examples: rcadm --manage --remove-spare --array 5 --disk *
rcadm -M -rs -a * -d 5

REMOVE ALL SPARES

--remove-all-spares --array <list>
-ras -a <list>

Examples: rcadm --manage --remove-all-spares --array 5
rcadm -M -ras -a *

ADD GLOBAL SPARE

--add-global-spare --disk <list>
-ags -d <list>

Examples: rcadm --manage --add-global-spare --disk 1 2 3
rcadm -M -ags -d *

REMOVE GLOBAL SPARE

--remove-global-spare --disk <list>
-rgs -d <list>

Examples: rcadm --manage --remove-global-spare --disk *
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rcadm -M -rgs -d 5

CACHE SETTINGS FOR ARRAYS
--cache-array <cache_attribute> --array <list>
-ca <cache_attribute> -a <list>
Cache attributes: <r> for read cache
<rw> for read and write-back cache
<w> for write-back cache
<nc> for no cache
Examples: rcadm --manage --cache-array rw --array *
rcadm -M -ca nc -a 1l

DISK SETTINGS (Advanced)
Disk cache:

--cache-disk <cache_ attribute> --disk <list>
-cd <cache_attribute> -d <list>

Cache attributes: <r> for read cache

<rw> for read and write-back cache
<w> for write-back cache
<nc> for no cache
Examples: rcadm --manage --cache-disk r --disk 1 2 3
rcadm -M -cd w -d *

HIDE ARRAY

--hide --array <list>
-h -a <list>
Examples: rcadm --manage --hide --array 5 6

rcadm -M -h -a 4

UNHIDE ARRAY

--unhide --array <list>
-uh -a <list>
Examples: rcadm --manage --unhide --array *

rcadm -M -uh -a 5

INITIALIZE DISK
——i1nitialize-disk --disk <list>

March 2018
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-id -d <list>
Examples: rcadm --manage --initialize-disk --disk *

rcadm -M -id -d 1 2 3

NAME ARRAY
--name "‘name" --array <list>
-n "name" -a <list>
Examples: rcadm --manage --name ''System Disk™ --array 5

rcadm -M -n "Backup Disk"™ -a 4

QUERY

--query [--array <list>] [--disk <list>]
[--verbose]
-q [-a <list>] [-ct <list>] [-d <list>] [-V]
Examples: rcadm --manage --query --array 1 --disk --verbose

rcadm -M -g -a 1 2 3 -d -v

QUERY ALL

-—-query-all
Example: rcadm --manage --query-all
RESCAN DISKS

—--rescan
-rsc

Example: rcadm --manage --rescan
SCAN ARRAY

--scan-array <on|off> --array <array_number>
-sa <on]off> -a <array_number>

Example: rcadm -M --array 1 --scan-array on

rcadm -M -a 1 -sa off

SMART POLL

--smart-poll <on]off> --disk <list>
-sp <on]off> -d <list>
Example: rcadm --manage --smart-poll on --disk

rcadm -M -sp off -d 1 2 3

TASK CONTROL

--task <task operation> --array <array_number>
-t <task_operation> -a <array_number>
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Task Operation
<pause> to temporarily pause a task
<resume> to continue running a task
<remove> to permanently remove a task
Examples: rcadm --manage --task pause --array 5
rcadm -M -t remove -a 4

TASK PRIORITY

—--priority <1..10> --array <list>
-p <1..10> -a <list>
Examples: rcadm --manage --priority 5 --array 6

rcadm -M -p 1 -a
UNLINK ARRAY

--unlink --array <array_number>
-ul -a <array_number>

Examples: rcadm --manage --unlink --array 2

rcadm -M -ul -a 5
10.8.3 rcadm -C

CREATE

Long form:
rcadm --create <raid_type> --disk <list> [--size <size_mb>]

[--sub-member <num>] [--spare-disk <list>]
[--no-sync] [--d-spare] [--cache <r,rw,w,nc>]
[--max-size] [--name "name™] [--priority <1..10>]
[--zero][--scan-array]

Short form:

rcadm -C <raid_type> -d <list> [-s <size_mb>] [-sub <num>]
[-sp <list>] [-ns] [-ds] [-ca <r, rw, w, nc>] [-ms]
[-n "name™] [-p <1..10>] [-z] [-sa] }
RAID Types:

--volume, -v Single disk or concatenation of disks (JBOD)
--raidable, -ra Single disk, RAIDABLE
--raidO, -rO Stripe of two or more disks
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—-raidl, -rl1 Mirror of two disks
--raid10, -r10 Stripe set of mirror sets

OPTIONS

-sp, —--spare-disk

Specifies the dedicated spare disk or disks to assign, with a maximum of four. No space is
reserved on the selected disks.

-s, --size
Specifies the size of the array in MBs. If you do not use this option, the largest possible size is
used by default.

-Nns, --no-sync
Disables background synchronization of redundant types when creating the array.

-ca, --cache
Specifies a cache setting for the array(s): read cache <r>, read and write-back cache <rw>, write-
back cache <w>, or no cache <nc>. The default is read and write-back cache <rw>.

-cts, --cachetagsize

Specifies the Cache Tag Size. This is the amount of data per disk in a stripe. Supported sizes are
64, 128, or 256; sizes in kB.

Please refer to Table 17, Default Cache Tag Size, on page 52.

-ms, --max-size
Prints the maximum possible size for an array without actually creating an array.

-n, —--name
Identifies an array with a user-supplied name. The name can be up to 30 characters, but only 17 of
those characters display in the BIOS.

-p, --priority
Sets the background initialization task priority from 1 to 10, with 10 being the highest priority. For
redundant array types only.

-led, --leave-existing-data

Leaves the existing data on the disks untouched after the array is created. This option can be used
to try to recover user data when an array has been accidentally deleted or the configuration
information is lost but the data is still intact. Unless you immediately recreate the array after
deleting it and no other tasks have been performed, the likelihood of recovering data with this
method is very low.

-d, --disk
A required qualifier used with the --create option to specify the disk or disks to be included in the
array.
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-Sa, -—--SCan-array

Specifies that a background array scan should be continuously run whenever the array is idle
(Default is off).

-Z, —-Z€ero

Zero the array in the foreground. This method is faster than doing a background consistency
verifies if the array is a redundant type. For non-redundant types, the zero option can be used to
verify all blocks in the array can be accessed.

EXAMPLES
Example: Create a RAIDI set of the maximum possible size using all disks.
rcadm -C -raidl --disk *

Example: Create a RAIDI set of the maximum possible size, with a spare disk and without a
background initialization task.

rcadm -C --raidl --spare-disk 3 --disk 1 2 --no-sync
10.8.4 rcadm -D

DELETE

Long form:

--delete --array <list> [--no-ask]
Short form:

-D -a <list> [-na] [-cg <group number>]
OPTIONS

-na, --no-ask

If the no ask option is specified the array is deleted without confirmation.

EXAMPLES
Example: Delete arrays 1 and 2.

rcadm -D --array 1 2

Example: Delete all arrays.

rcadm -D --array
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Chapter 11

AMD-RAIDXpert2 User Guide

Troubleshooting

11.1 Troubleshooting

The chapter discusses four major categories of troubleshooting:

e Problems with system startup.

e Warning messages that might appear at the Power-On Self-Test (POST) screen.

e Problems with arrays.
e Problems with disks.

11.2 System Startup Problems

Table 35. The System Does Not Boot
Table 36. The BIOS Configuration Utility Does Not Display

Table 35. The System Does Not Boot

Possible Causes

Corrective Actions

Controller mode is set
incorrectly during system
startup

In the system’s BIOS screen, ensure SATA settings are in RAID
mode.

The system’s boot mode or
boot sequence retry mode
is set incorrectly

In the system’s BIOS screen, ensure that the bootable array is the first
array listed.

If not, use the Swap Two Arrays option to reposition the arrays.

A bootable array is in an
Offline state

Restart the system.

Enter the system’s BIOS screen.
Check the state of the bootable array.
Check for missing or offline disks.

Table 36. The BIOS Configuration Utility Does Not Display

Possible Causes

Corrective Actions

The controller mode is set
incorrectly in the system
BIOS

In the system’s BIOS screen, ensure the SATA settings are correct.
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Problem

Corrective Actions

A user forgets the
username or password.

Reset the username and password by deleting rc_login.txt. This
restores the default user name and password (admin and admin).

11.3

The POST screen is one of the first screens to appear during the system’s boot sequence. If the
system’s arrays were in Normal or Ready state prior to a system boot, the boot sequence continues

normally to the operating system.

Warning Messages: POST Screen

But, if an array is in Critical or Offline state, or if specific options at Controller Options were

changed previously at the BIOS Configuration Utility, the warning messages described in Table

38 appear during the boot sequence.

Table 38. POST Screen Warning Messages

Warning Message

Additional Information

Corrective Action

WARNING: Found arrays
that are Critical
[or equivalent]

This warning message appears when at
least one array is in a Critical state and
Toggle Pause if Critical is set to ON at
the BIOS Configuration Utility.

The Critical state of an array depends on
the RAID level of the array and the
number of disks that have failed. See
Section 3.3, Array States, on page 27, for
information on criticality.

If an array is Critical (even a bootable
array), the system can continue through
the boot process to the operating system.

See Section 11.5.1,
Troubleshooting Disks, on
page 135.
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Table 38. POST Screen Warning Messages (Continued)
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Warning Message

Additional Information

Corrective Action

WARNING: Found
arrays that are Offline

[or equivalent]

WARNING: Found
arrays that are Critical
and Offline

[or equivalent]

This warning message appears when at
least one array is in an Offline state and
Toggle Pause if Offline is set to ON at
the BIOS Configuration Utility.

If two or more disks in a redundant array
have failed, or if a single or multiple
disks in a non-redundant array have
failed, data has been lost.

In RAID10 array, if a single disk fails in
each mirrored set, the redundant array
goes to a Critical state but data is not
lost. If two disks fail in one of the
mirrored sets, the redundant array goes to
an Offline state and data is lost.

A bootable array that is in an Offline
state prevents the operating system from
booting.

See Section 11.5.1, Troubleshooting
Disks, on page 135.

If, after performing a rescan, the state
remains Offline, the bootable array has
suffered an unrecoverable failure.
Create a new bootable array.

Reinstall the operating system and
drivers.

BIOS NOT INSTALLED -
User Disabled INT13
BIOS Load

[or equivalent]

This warning message appears when
Toggle INT13 Boot Support option has
been set to OFF at the BIOS
Configuration Utility and another boot
device is not selected.

Bootable devices do not function with
the controller when Toggle INT13 Boot
Support is set to OFF. The default
setting is ON, which allows bootable
devices to function with the controller.

Restart the system.
Enter the system’s BIOS screen.

Select Main Menu > Controller
Options > Toggle INT13 Boot Support.

Change Toggle INT13 Boot Support
from OFF to ON.

Navigate to Main Menu.
Select Continue to Boot.

The system boot process continues to the
operating system.

11.4

Array-Related Errors

e Table 39. Cannot Create an Array, on page 132

e Table 41. An Array is in an Offline State, on page 133

e Table 40. An Array is in a Critical State, on page 133

e Table 42. Cannot Assign a Dedicated Spare to an Array, on page 133

e Table 43. Cannot Create a Global Spare, on page 134

e Table 44. Recreate a Deleted Array, on page 134
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Possible Causes

Additional Information

Corrective Actions

The disk is not displayed.

The controller cannot communicate
with the disks.

See Section 11.5.1, Troubleshooting
Disks, on page 135.

Insufficient free space
available on the selected
disks

Select a different combination of
disks.

Incorrect number of disks
selected for the desired
RAID level

See 3.2, RAID Levels, on page 26,
for a description of RAID levels and
the allowable number of disks used
with each RAID level.

Select the correct number of disks.

The desired disk is
unavailable.

The disk is a dedicated spare for a
different array.

The disk is full.

The disk’s available capacity is
insufficient.

Select a different disk.

The disk has SMART
erTors.

An array can be created with a disk
that has SMART errors, but only if
the array is created in the BIOS
Configuration Utility.

RAIDXpert2 cannot be used to
create an array with a disk that has
SMART errors.

Use the BIOS Configuration Utility to
create the array.

The system already has a
maximum of eight arrays

Delete unused arrays.

CAUTION: Deleting an array
permanently destroys all data that is
on the array. This action cannot be
undone and it is very unlikely the data
can be recovered.
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Table 40. An Array is in a Critical State

Possible Causes Additional Information Corrective Actions
One or more disks in the  |Due to the failed disk or disks, the array is no See Section 11.5.1,
array have failed or been |longer maintaining redundant (mirrored or parity) |Troubleshooting Disks,
removed. data. on page 135.

The failure of an additional disk results in an
Offline state and lost data.

Table 41. An Array is in an Offline State

Possible Causes Additional Information Corrective Actions
The array has lost the One or more disks have failed. See Section 11.5.1,
per RAID level. single disk causes the array to fail. on page 135.

e I[fthe array is redundant, the failure of two or
more disks causes the array to fail.

The array cannot be restored (rebuilt).

Table 42. Cannot Assign a Dedicated Spare to an Array

Possible Causes Additional Information Corrective Actions

The RAID level does not  |Dedicated spares cannot be created for |e  Create an array with a different
allow dedicated spares. Volume or RAIDO arrays. RAID level and assign a

dedicated spare.
e C(reate a global spare.

The designated disk does |The capacity of the disk selected to be a |Select a different disk.

not have sufficient dedicated spare must be equal to or
capacity to be a dedicated |larger than the capacity of the smallest
spare disk in the array.
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Possible Causes

Additional Information

Corrective Actions

The disk is already part of
an array

A global spare cannot be selected if it
is already part of an existing array.

Select a different disk.

There are no empty disks
available or the disks have
not been initialized

A disk with a legacy state can be
initialized, if desired, but it is no
longer legacy (initialization adds

RAIDXpert2 configuration
information to the disk).

Install additional disks.
Initialize the disks.

CAUTION: When a disk is initialized,
all data on the disk is lost.

The disk assigned as the
global spare has failed or is
missing.

See Section 11.5.1, Troubleshooting
Disks, on page 135.

Table 44. Recreate a Deleted Array

Possible Causes

Additional Information

Corrective Actions

An array(s) was
accidentally deleted, or the
wrong array was deleted

This procedure might
recreate a deleted array and
with its data intact.
However, this is not
guaranteed to occur.

If I/O was running to the
deleted array(s) just prior
to it being deleted, there
might be some data loss in
the recreated array(s).

If multiple arrays were
deleted, all of the deleted

arrays must be recreated in |

order to recover the desired
array.

Qs e

At the Array pop-up menu, select Create.

Create a new array using the same settings
as the deleted array.

The same disks.

The same RAID type (RAID level).
The same capacity.

The same cache options.

Check Leave Existing Data Intact.
Click Create.

Ensure the settings are the same as the
deleted array:

The same drive letter.

The same RAID type (RAID level).
The same disks.

The same capacity.

The same cache option

Check the data files of the array for
corrupted or missing files, incorrect file
extensions, and so on.
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11.5 Disk Related Errors

e Table 45. Disk Errors
e Section 11.5.1, Troubleshooting Disks, on page 135.

Table 45. Disk Errors
Possible Causes Additional Information Corrective Actions
A disk has been removed from See Section 11.5.1,
an array Troubleshooting Disks, on page

135.
A disk is not visible in the BIOS
Configuration Utility or is offline

A disk is highlighted red at the  |The disk has failed.

BIOS Configuration Utility Depending on the RAID level of
the array, data might be lost.

RAIDXpert2 cannot The dedicated spare is not visible
communicate with the spare in the BIOS Configuration Utility
or is offline.

The disk cannot be initialized Only disks that are Ready can be

Ensure the disk is not already

initialized. a member of an array.

CAUTION: When a disk is e Ensure the disk is still

initialized, all data on the disk is assigned as a global or
lost. dedicated spare.

e Ensure the disk is reporting a
Ready state.

11.5.1  Troubleshooting Disks
Perform the following actions when there may be a problem with a disk.

e Ensure there is no damage to the system’s backplane.

e Ensure all cables are installed correctly.

e Ensure the disk is seated correctly in the backplane or bay and the latch is secured.
e Reinsert the disk.

e Replace the disk.

e After reconnecting, reseating, reinserting, or replacing a disk:

0 Perform a rescan.
0 Initialize the disk.
CAUTION: When a disk is initialized, all data on the disk is lost.
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If problems with a disk have caused an array to go Critical, it may be necessary to also assign a
dedicated or global spare for the array.

If problems with a disk have caused an array to go Offline, data may have been lost. Recover lost
data from a backup storage source.
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Chapter 12 Software License: EULA

12.1 Software License: End-User License Agreement
(EULA)

BY INSTALLING, DOWNLOADING AND/OR USING THE SOFTWARE THAT
ACCOMPANIES THIS END USER LICENSE AGREEMENT (“AGREEMENT”) AND ANY
ASSOCIATED DOCUMENTATION OR UPDATES THERETO ("SOFTWARE"), YOU
AGREE THAT, WHETHER AS AN INDIVIDUAL OR AUTHORIZED REPRESENTATIVE
OF AN ENTITY, YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND AGREE
TO BE BOUND BY IT. IF YOU DO NOT AGREE TO IT, YOU ARE NOT AUTHORIZED TO
INSTALL, DOWNLOAD OR OTHERWISE USE THE SOFTWARE AND ARE ASKED TO
PLEASE RETURN THE SOFTWARE TO THE PARTY FROM WHOM YOU RECEIVED IT.
THE RIGHT TO USE THE SOFTWARE IS GRANTED ONLY UPON THE CONDITION
THAT YOU AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT.

FURTHER, YOU UNDERSTAND THAT THIS SOFTWARE MAY ONLY BE OBTAINED
FROM Advanced Micro Devices, Inc. (“AMD”) OR AN AUTHORIZED DISTRIBUTOR OF
AMD. IF YOU OBTAINED THIS SOFTWARE FROM ANY OTHER SOURCE, THAT
SOURCE PROVIDED IT TO YOU ILLEGALLY, AND YOU HAVE NO RIGHT TO
INSTALL, DOWNLOAD OR OTHERWISE USE THE SOFTWARE; SUCH USE IS A
VIOLATION OF INTELLECTUAL PROPERTY RIGHTS.

12.1.1 Limited License to Authorized Distributors

If you are an OEM, distributor, reseller, integrator or other entity in the business of providing
technology products and/or services, and if you have been expressly authorized to distribute copies
of the Software to End User(s), you are an "Authorized Distributor." Subject to the terms and
conditions of this Agreement, you are granted a limited, non-exclusive, non-transferable, non-sub
licensable license to distribute and/or install the Software in its unaltered, object code form solely
(1) to, and on behalf of, a purchasing End User for the End User’s internal business purposes; and
(i1) only for use with one (1) AMD product, purchased through authorized AMD sales channels.
Except as specifically stated in this Section 1, Authorized Distributors are expressly prohibited
from: copying and/or distributing the Software in whole or in part; using the Software to provide
consulting or other services to third parties; and distributing the Software in any form or format.
Authorized Distributors are subject to all other terms and conditions of this Agreement.
Authorized Distributors must ensure that its End Users see and agree to this Agreement.

12.1.2 Limited License to End Users

If you have licensed the Software for your own personal use or your company's internal use, you
are an "End User." You are hereby granted, subject to the terms and conditions of this Agreement,
a limited, non-exclusive, non-transferable, non-sublicensable license to use this Software in its
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unaltered, object code form solely (i) for internal business purposes; and (ii) only with respect to
one (1) AMD product that was purchased through authorized AMD sales channels. Further, you
must obtain this Software only from authorized AMD sales channels. Obtaining it from any other
source is a violation of the intellectual property rights of AMD and its licensors.

12.1.3 Restrictions

Except as expressly authorized in Sections 1 and 2 above, Authorized Distributors and End Users
(collectively "You”) shall not (nor cause or permit any other person to): (i) reverse engineer,
translate, disassemble, derive source code from, decompile, rent, lease, manufacture, adapt, create
derivative works from, or otherwise modify or distribute the Software or any part thereof; (i1)
copy, in whole or in part, the Software with the exception that only End Users may make one copy
of the Software for their backup or archival purposes; (iii) publicly display the Software or use the
Software to provide consulting or other services to third parties; or (iv) delete any copyright,
trademark, patent or other notices of proprietary rights as they appear anywhere in or on the
Software.

12.1.4  Proprietary Rights

The Software is primarily the intellectual property of Seagate Technology PLC. (“Seagate”) and
its licensors (“Licensors”). In no event shall You obtain title to the Software or any component
thereof. As between Seagate and You, Seagate has all rights, title, interest, ownership and
proprietary rights in and to the Software. Seagate's rights include, but are not limited to, all copies
of the Software and any patent rights, copyrights, trademark rights, trade secret rights, and any
other intellectual property right recognized in any country or jurisdiction in the world. The
Software is protected both by United States law and international treaty provisions. All rights not
expressly granted in this Agreement are reserved by Seagate and Licensors, respectively.

12.1.5 Terms and Conditions

This Agreement shall continue in effect until terminated. Seagate or AMD may terminate this
Agreement immediately if You fail to comply with any provision of this Agreement. Upon
termination, You shall discontinue use of the Software, and either destroy, erase, or return all
copies of the Software in Your possession or control.

12.1.6 No Warranty

THE SOFTWARE IS PROVIDED "AS IS" WITHOUT ANY WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED. SEAGATE AND AMD DISCLAIM, ON THEIR OWN BEHALF
AND ON BEHALF OF LICENSORS, ANY EXPRESS OR IMPLIED WARRANTIES
INCLUDING ANY IMPLIED WARRANTIES OF NONINFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OF THE SOFTWARE
OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR
ERROR-FREE OR WILL OPERATE IN COMBINATION WITH OTHER SOFTWARE OR
HARDWARE. Seagate and its Licensors will not provide support for the Software and, to the
extent you believe that are entitled to support, you are advised to contact the party from whom you
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received the Software. Notwithstanding the foregoing, Updates to the Software (which may or
may not be distributed) shall be governed by this Agreement, and such Updates will be considered
Software for purposes of this Agreement.

The Software is not absolutely fault-tolerant and is not designed, manufactured or intended for use
or resale as on-line control equipment in hazardous environments requiring fail-safe performance
in which the failure of the Software could lead directly to death, personal injury or severe physical
or environmental damage, such as the operation of nuclear facilities, aircraft navigation, air traffic
control, direct life support machines, or weapons systems (“High Risk Activities”). Express or
implied warranties for High Risk Activities are specifically disclaimed.

12.1.7  Limitation of Liability

IN NO EVENT SHALL SEAGATE, AMD OR LICENSORS BE LIABLE TO ANY PARTY
FOR ANY LOST REVENUE, LOST PROFIT OR DATA, OR FOR SPECIAL, INDIRECT,
CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED, AND
REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR
INABILITY TO USE THE SOFTWARE EVEN IF THEY HAVE BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL SEAGATE’s, AMD’s or
LICENSORS’ LIABILITY, TO YOU, WHETHER IN CONTRACT, TORT (INCLUDING
NEGLIGENCE) OR OTHERWISE, EXCEED THE AMOUNT OF ANY FEE PAID BY YOU
FOR THE SOFTWARE. THE FOREGOING LIMITATIONS SHALL APPLY EVEN IF THE
REMEDY FAILS OF ITS ESSENTIAL PURPOSE. Some jurisdictions do not allow for the
exclusion of implied warranties as described in Section 6, or the limitation of liabilities as
described in this Section 7, so the above exclusions or limitations may not apply to You. In that
event, to the extent permissible, any exclusion of warranties or limitation of liability will be
limited in duration or type to the greatest extent allowed by law.

12.1.8  Export Controls

You agree to comply fully with all relevant export laws, regulations, treaties, and orders ("Export
Laws") to assure that neither the Software nor any components thereof are (i) exported, directly or
indirectly, in violation of Export Laws; or (ii) are intended to be used or are used for any purposes
prohibited by the Export Laws.

12.1.9 General

This Agreement and any disputes arising from or relating to it shall be governed by and construed
in accordance with the laws of the State of Colorado without reference to conflict of laws
principles and excluding the U.N. Convention on Contracts for the International Sale of Goods.
Any legal action or proceeding shall be instituted in a state or federal court in Denver, Colorado,
U.S.A. and You agree to be subject to the jurisdiction of these courts. Taxes and charges imposed
by any government with respect to the Software shall be paid by the End User. The waiver by
either party of a breach of this Agreement or a failure to exercise any right hereunder shall not
operate or be construed as a waiver of any subsequent breach or as a waiver of any other right. If
any provision of this Agreement is held to be unenforceable or overbroad for any reason, it will be
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modified rather than voided, if possible, in order to achieve the intent of the parties to the extent
necessary to make the provision enforceable under applicable law, and enforced as amended. In
any event, all other provisions of this Agreement will be deemed valid and enforceable to the full
extent. This Agreement constitutes the complete agreement between the parties and supersedes all
prior or contemporaneous agreements or representations, written or oral, concerning the subject
matter of this Agreement including any purchase order or ordering document. This Agreement
may not be modified or amended except in writing and signed by both parties.
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